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2.5.1.1.1.4.5.3.3.2. column

Copyright © 2011 SoftFluent S.A.S. All Rights Reserved.

14

515
515-516
516
516-517
517
517-518
518
518-519
519
519-520
520
520-521
521

521
521-522
522
522-523
523
523-524
524
524-525
525-526
526

526
526-527
527
527-528
528
528-529
529
529-530
530



CodeFluent Entities Documentation

2.5.1.1.1.4.5.3.3.2.1. attribute
2.5.1.1.1.4.5.3.3.2.1.1. argument
2.5.1.1.1.4.5.3.3.2.1.1.1. message
2.5.1.1.1.4.5.3.3.2.1.2. message
2.5.1.1.1.4.5.3.3.2.2. field
2.5.1.1.1.4.5.3.3.2.2.1. attribute
2.5.1.1.1.4.5.3.3.2.2.1.1. argument
2.5.1.1.1.4.5.3.3.2.2.1.1.1. message
2.5.1.1.1.4.5.3.3.2.2.1.2. message
2.5.1.1.1.4.5.3.3.2.2.2. message
2.5.1.1.1.4.5.3.3.2.3. message
2.5.1.1.1.4.5.3.3.3. message
2.5.1.1.1.4.5.4. message
2.5.1.1.1.4.5.5. parameter
2.5.1.1.1.4.5.5.1. attribute
2.5.1.1.1.4.5.5.1.1. argument
2.5.1.1.1.4.5.5.1.1.1. message
2.5.1.1.1.4.5.5.1.2. message
2.5.1.1.1.4.5.5.2. message
2.5.1.1.1.4.5.5.3. renderer
2.5.1.1.1.4.5.5.4. rule
2.5.1.1.1.4.5.5.4.1. attribute
2.5.1.1.1.4.5.5.4.1.1. argument
2.5.1.1.1.4.5.5.4.1.1.1. message
2.5.1.1.1.4.5.5.4.1.2. message
2.5.1.1.1.4.5.5.4.2. body
2.5.1.1.1.4.5.5.4.3. message
2.5.1.1.1.4.5.6. rule
2.5.1.1.1.4.5.6.1. attribute
2.5.1.1.1.4.5.6.1.1. argument
2.5.1.1.1.4.5.6.1.1.1. message

2.5.1.1.1.4.5.6.1.2. message

Copyright © 2011 SoftFluent S.A.S. All Rights Reserved.

15

530-531
531
531-532
532
532-533
533
533-534
534
534-535
535
535
535-536
536
536-537
537
537-538
538
538-539
539
539-540
540
540-541
541
541-542
542
542-543
543
543-544
544
544-545
545
545-546



CodeFluent Entities Documentation

2.5.1.1.1.4.5.6.2. body
2.5.1.1.1.4.5.6.3. message
2.5.1.1.1.4.5.7. setting
2.5.1.1.1.4.5.7.1. attribute
2.5.1.1.1.4.5.7.1.1. argument
2.5.1.1.1.4.5.7.1.1.1. message
2.5.1.1.1.4.5.7.1.2. message
2.5.1.1.1.4.5.7.2. message
2.5.1.1.1.4.6. parameter
2.5.1.1.1.4.6.1. attribute
2.5.1.1.1.4.6.1.1. argument
2.5.1.1.1.4.6.1.1.1. message
2.5.1.1.1.4.6.1.2. message
2.5.1.1.1.4.6.2. message
2.5.1.1.1.4.6.3. renderer
2.5.1.1.1.4.6.4. rule
2.5.1.1.1.4.6.4.1. attribute
2.5.1.1.1.4.6.4.1.1. argument
2.5.1.1.1.4.6.4.1.1.1. message
2.5.1.1.1.4.6.4.1.2. message
2.5.1.1.1.4.6.4.2. body
2.5.1.1.1.4.6.4.3. message
2.5.1.1.1.4.7. property
2.5.1.1.1.4.7.1. attribute
2.5.1.1.1.4.7.1.1. argument
2.5.1.1.1.4.7.1.1.1. message
2.5.1.1.1.4.7.1.2. message
2.5.1.1.1.4.7.2. message
2.5.1.1.1.4.7.3. renderer
2.5.1.1.1.4.7.4. rule
2.5.1.1.1.4.7.4.1. attribute

2.5.1.1.1.4.7.4.1.1. argument

Copyright © 2011 SoftFluent S.A.S. All Rights Reserved.

16

546
546-547
547
547-548
548
548-549
549
549-550
550
550-551
551
551-552
552
552
552-553
553-554
554
554-555
555
555-556
556
550-557
557
557-558
558
558-559
559
559
559-560
560-561
561
561-562



CodeFluent Entities Documentation

2.5.1.1.1.4.7.4.1.1.1. message
2.5.1.1.1.4.7.4.1.2. message
2.5.1.1.1.4.7.4.2. body
2.5.1.1.1.4.7.4.3. message
2.5.1.1.1.4.8. renderer
2.5.1.1.1.4.9. rule
2.5.1.1.1.4.9.1. attribute
2.5.1.1.1.4.9.1.1. argument
2.5.1.1.1.4.9.1.1.1. message
2.5.1.1.1.4.9.1.2. message
2.5.1.1.1.4.9.2. body
2.5.1.1.1.4.9.3. message
2.5.1.1.1.4.10. setRenderer
2.5.1.1.1.4.11. setSnippet
2.5.1.1.1.4.12. snippet
2.5.1.1.1.4.13. vView
2.5.1.1.1.4.13.1. attribute
2.5.1.1.1.4.13.1.1. argument
2.5.1.1.1.4.13.1.1.1. message
2.5.1.1.1.4.13.1.2. message
2.5.1.1.1.4.13.2. message
2.5.1.1.1.4.13.3. viewProperty
2.5.1.1.1.4.13.3.1. attribute
2.5.1.1.1.4.13.3.1.1. argument
2.5.1.1.1.4.13.3.1.1.1. message
2.5.1.1.1.4.13.3.1.2. message
2.5.1.1.1.4.13.3.2. message
2.5.1.1.1.4.13.3.3. renderer
2.5.1.1.1.4.13.3.4. rule
2.5.1.1.1.4.13.3.4.1. attribute
2.5.1.1.1.4.13.3.4.1.1. argument

2.5.1.1.1.4.13.3.4.1.1.1. message

Copyright © 2011 SoftFluent S.A.S. All Rights Reserved.

17

562
562-5603
563
563-564
564
564-565
565-506
566
566
506-567
5607
568
568-569
569
569-570
570
570-571
571
571-572
572
572-573
573
573-574
574
574-575
575
575
576
576-577
577
577-578
578



CodeFluent Entities Documentation

2.5.1.1.1.4.13.3.4.1.2. message
2.5.1.1.1.4.13.3.4.2. body
2.5.1.1.1.4.13.3.4.3. message
2.5.1.1.1.5. enumeration
2.5.1.1.1.5.1. attribute
2.5.1.1.1.5.1.1. argument
2.5.1.1.1.5.1.1.1. message
2.5.1.1.1.5.1.2. message
2.5.1.1.1.5.2. enumerationValue
2.5.1.1.1.5.2.1. attribute
2.5.1.1.1.5.2.1.1. argument
2.5.1.1.1.5.2.1.1.1. message
2.5.1.1.1.5.2.1.2. message
2.5.1.1.1.5.2.2. message
2.5.1.1.1.5.3. message
2.5.1.1.1.6. import
2.5.1.1.1.7. message
2.5.1.1.1.8. pattern
2.5.1.1.1.8.1. descriptor
2.5.1.1.1.9. producer
2.5.1.1.1.10. reference
2.5.1.1.1.11. rule
2.5.1.1.1.11.1. attribute
2.5.1.1.1.11.1.1. argument
2.5.1.1.1.11.1.1.1. message
2.5.1.1.1.11.1.2. message
2.5.1.1.1.11.2. body
2.5.1.1.1.11.3. message
2.5.1.1.1.12. schema
2.5.1.1.1.12.1. attribute
2.5.1.1.1.12.1.1. argument

2.5.1.1.1.12.1.1.1. message

Copyright © 2011 SoftFluent S.A.S. All Rights Reserved.

18

578-579
579
579-580
580
580-581
581
581-582
582
582-583
583
583-584
584
584
584-585
585
585-586
586
586-587
587
587-588
588-589
589
589-590
590
590-591
591
591-592
592
592-593
593-594
594
594



CodeFluent Entities Documentation

2.5.1.1.1.12.1.2. message
2.5.1.1.1.12.2. message
2.5.1.1.1.13. set
2.5.1.1.1.13.1. attribute
2.5.1.1.1.13.1.1. argument
2.5.1.1.1.13.1.1.1. message
2.5.1.1.1.13.1.2. message
2.5.1.1.1.13.2. message
2.5.1.1.1.14. store
2.5.1.1.1.15. surface
2.5.1.1.1.16. userType
2.5.1.1.1.16.1. attribute
2.5.1.1.1.16.1.1. argument
2.5.1.1.1.16.1.1.1. message
2.5.1.1.1.16.1.2. message
2.5.1.1.1.16.2. message
2.5.1.1.1.16.3. renderer
2.5.1.1.1.16.4. rule
2.5.1.1.1.16.4.1. attribute
2.5.1.1.1.16.4.1.1. argument
2.5.1.1.1.16.4.1.1.1. message
2.5.1.1.1.16.4.1.2. message
2.5.1.1.1.16.4.2. body
2.5.1.1.1.16.4.3. message
2.5.1.2. Business Object Model Producer
2.5.1.2.1. configuration
2.5.1.2.1.1. compileFile
2.5.1.2.1.2. embedResource
2.5.1.2.1.3. reference
2.5.1.2.1.4. subProducer
2.5.1.3. Service Object Model Producer

2.5.1.3.1. subProducer

Copyright © 2011 SoftFluent S.A.S. All Rights Reserved.

19

594-595
595
595-596
596
596-597
597
597-598
598
598-599
599-600
600

600-601
601
601-602
602

602
602-603
603-604
604
604-605
605
605-606
606
606-607
607-608
608
608-609
609

610

610
611-612

612



CodeFluent Entities Documentation

2.5.1.4. Object Model Cache Sub Producer
2.5.1.4.1. subProducer
2.5.1.4.2. cache
2.5.1.5. LINQ to SQL Sub Producer
2.5.1.5.1. subProducer
2.5.1.6. Template Producer
2.5.1.6.1. configuration
2.5.1.7. Microsoft SQL Server Producer
2.5.1.7.1. configuration
2.5.1.8. Microsoft SQL Server Template Producer
2.5.1.8.1. configuration
2.5.1.9. Web Services Producer
2.5.1.9.1. configuration
2.5.1.10. Web Controls Producer
2.5.1.10.1. configuration
2.5.1.10.1.1. controlProducers
2.5.1.10.1.1.1. controlProducer
2.5.1.11. Web Site Producer
2.5.1.11.1. configuration
2.5.1.12. Microsoft Office Lists Producer
2.5.1.12.1. configuration
2.5.1.13. Microsoft SharePoint Producer
2.5.1.13.1. configuration
2.5.1.14. Localization Pattern
2.5.1.14.1. import
2.5.1.15. Auto Formattable Pattern
2.5.1.16. Association Manage Pattern
2.5.2. CodeFluent Query Language (CFQL)
2.5.2.1. Overview
2.5.2.2. CFQL Formal Grammar
2.5.2.3. Load methods
2.5.2.4. Search methods

Copyright © 2011 SoftFluent S.A.S. All Rights Reserved.

20

612
612-613
613
613-614
614-615
615

615
615-617
617-618
618

618
618-619
619

619
619-620
620
620-621
621
621-622
622-623
623
623-624
624
624
624
625

625
625-626
626-630
630-635
635-636
636



CodeFluent Entities Documentation

2.5.2.5. Count methods
2.5.2.6. Delete methods
2.5.2.7. CFQL Operators
2.5.2.8. Rule methods
2.5.2.8.1. Script rule engine settings
2.5.2.8.2. Ilog Rules for .NET (R) rule engine settings
2.6. Tutorials
2.6.1. Using The Core Edition
2.6.1.1. Microsoft Visual Studio Integration
2.6.1.2. Developing Desktop Applications
2.6.1.2.1. Developing Rich Clients
2.6.1.2.1.1. The Persistence and the Business Layers
2.6.1.2.1.2. A Custom Windows Forms Rich Client
2.6.1.2.1.3. A Custom WPF Rich Client
2.6.1.2.2. Developing Smart Clients
2.6.1.2.2.1. The Persistence, the Business, and the Service Layers
2.6.1.2.2.2. A Custom Windows Forms Smart Client
2.6.1.2.2.3. A Custom WPF Smart Client
2.6.1.3. Developing ASP.NET Applications
2.6.1.3.1. The Persistence and the Business Layers
2.6.1.3.2. A Custom ASP.NET Web Site
2.6.1.4. Developing Silverlight Applications
2.6.1.4.1. The Persistence, the Business, and the Silverlight Object Model
2.6.1.4.2. A Custom Silverlight Client
2.6.1.5. Integrating Microsoft Office
2.6.1.5.1. Developing Microsoft Office Synchronizable Lists
2.6.1.5.2. Configuring Lists For Excel
2.6.1.5.3. Configuring Lists For Access
2.6.2. Using The Modeler Edition
2.6.2.1. Developing Desktop Applications
2.6.2.1.1. The Persistence and the Business Layers

2.6.2.1.2. A Custom Windows Forms Rich Client

Copyright © 2011 SoftFluent S.A.S. All Rights Reserved.

21

636

637
637-639
639-642
642-643
643

643
643-645
645-651
651

651
651-654
655-657
657-661
661
661-666
666-669
669-673
673
673-676
676-680
680
680-685
685-689
689
689-691
691-693
693-695
695-696
696
696-701
701-704



CodeFluent Entities Documentation

2.6.2.1.3. A Custom WPF Rich Client
2.6.2.2. Developing ASP.NET Applications
2.6.2.2.1. The Persistence and the Business Layers
2.6.2.2.2. A Custom ASP.NET Web Site
2.6.2.3. Using the WPF Smart Client Producer
2.7. Technical Articles
2.7.1. Project Templates For Visual Studio 2008
2.7.2. Using the Business Object Model in Windows PowerShell
2.7.3. Getting Started with the Microsoft SharePoint Producer
2.7.4. Using CodeFluent Entities with ASP.NET MVC 2
2.7.5. WPF MVVM with CodeFluent Entities
2.7.6. SoftFluent.Advertising: a purely model-driven application
2.7.7. Manipulating SQL Blobs With Streams
2.7.8. Generating Mobile-Enabled WCF Services Using CodeFluent Entities
2.7.8.1. Consuming Generated WCF Services in Android
2.7.8.2. Consuming Generated WCF Services in Windows Phone
2.7.8.3. Consuming Generated WCF Services in iOS

2.7.9. Creating A WPF Smart Client With Authentication Using CodeFluent
Entities

2.7.10. Windows Workflow Foundation 4 and CodeFluent Entities
2.7.11. Generating Java Using CodeFluent Entities and Hibernate
2.8. White Papers

2.8.1. How Model-Driven Software Development can help your projects
succeed

2.9. Glossary
3. Index

Copyright © 2011 SoftFluent S.A.S. All Rights Reserved.

22

704-708
708
708-713
713-717
717-730
730
730-733
733-735
735-751
751-764
764-777
778-790
790-795
795-800
800-810
810-817
817-825
825-838

838-853
853-867

867
867-879

879-881
882-894



CodeFluent Entities Documentation

2 CodeFluent Entities

The CodeFluent Entities Software Factory

CodeFluent Entities is a Model Driven Software Factory which allows you from a model to produce all
required layers and component for .NET business applications:

e Persistence layer

o Business Model layer

e Service Layer (Windows Communication Foundation Services, .ASMX Web Services V1)

e Presentation layer (ASP .NET, Windows Forms, Windows Presentation Foundation, SharePoint
WebParts).

CodeFluent
IFIPORTER

CodaFluent

iE il

XML Model CodeFluent
BUILDER

if i

CodeFluent
MODELER

CodeFluent Entities is a software factory.

A software factory is an industrialization software which applies manufacturing techniques and principles to
software development to mimic the benefits of traditional manufacturing.

Nowadays, most of software developments can be compared to a hand-crafted work which implies that the ratio
development effort / produced software is dramatically lower than an industrialized production. In a hand-
crafted development, the craftsman will develop his feature from scratch each time needed which outcomes in a
time waste.

This is a commonly known issue, and a widely spread way to address this issue is by developing frameworks.
Instead of developing the feature again and again throughout projects, the feature is made generic and included
in a framework so that this feature becomes reusable. Even though this approach is more productive on the long
term than a hand-crafted development, it creates, on a long term, possibly huge, hard to maintain and hard to
evolve frameworks. Moreover, in scenarios where a software development needs one precise feature of the
framework, it will have to drag the whole framework to benefit from the single given feature.

Finally, another solution to tackle the software productiveness issue, is the software factory development mode.
A software factory is a software or a software product line which allows developers to industrialize software
developments based on a software schema. In our case, CodeFluent Entities is a model driven software
factory which based on a model describing an application, will produce 100% functional components. To get
back to our example, the feature is provided by the software factory which, if defined in the model, will

be produced in the output software. This way, software developments are industrialized assuring shorter
development cycles, a higher quality, and avoids dragging complex and/or large frameworks since only the
desired features are used.

CodeFluent Entities documentation
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Introducing CodeFluent Entities (Section 2.1)

A quick overview of CodeFluent Entities (features, requirements, installation, support, etc.).

Development Tools (Section 2.2)

This section provides information on each of the tools provided with CodeFluent Entities,

Architect Guide (Section 2.3)

The Architect Guide contains detailed information of all concepts (Entities, Properties, Rules, Producers, etc.)
you’ll need to design your application.

Developer Guide (Section 2.4)

A guide intended to developers in charge of developing client applications (Desktop, Web, Silverlight,
SharePoint).

Reference Guide (Section 2.5)

Contains an exhaustive documentation of the complete schema.

Tutorials (Section 2.6)

Contains step by step examples to create applications using CodeFluent Entities.

Technical Articles (Section 2.7)

Contains technical articles related to the product.

White Papers (Section 2.8)

This section contains official SoftFluent white papers.
2.1 Introducing CodeFluent Entities

CodeFluent Entities is a product that enables developers to model a platform-independent application using
domain-specific objects and their related behaviors, and to generate all needed platform-dependent code and
components, eliminating the need for almost any foundation code that developers still have to think about and write
using any other tool.

Using CodeFluent Entities, architects define business models in a centralized place; choose target
platforms or technologies (including but not limited to data access), generate, and do it again continuously,
as much as needed, without losing existing data.

Using CodeFluent Entities, developers only write business-focused code or custom user interfaces, leveraging the
strongly-typed objects and artifacts that were produced automatically by the tool, as well as the numerous runtime
library classes and UI controls provided out-of-the box.

High-level capabilities of CodeFluent Entities

e Defines more than 40 platform-independent concepts for application design (Entity, Property, Methods, Forms,
Rules, Instances ...).

o Generates automatically platform-dependent files from these concepts: database schemas, tables, columns,
constraints, views, stored procedures, and row data; the corresponding .NET data access layer; WCF services,
configuration and enhanced proxies; Rules; Documentation; Ul artifacts.
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Works and integrates with a variety of technologies (including Microsoft SQL Server, SQL Azure, Oracle
Database, ASP.NET, SharePoint, Excel, WPF, Silverlight, Windows Forms, WCF)

Provides integrated Visual Studio tools to visually create models, to import models from existing models
(database, UML diagram, and Entity Framework models), and to generate all platform-dependent files from
these models.

Allows architect to define models “Aspects” to define behaviors and constraints that can be applied to concepts.
As an example, the “localization aspect” is provided out-of-the-box and allows localization of columns in the
database without any extra work.

In This Section

Features (Section 2.1.1)

Requirements (Section 2.1.3)

Support (Section 2.1.4)

Installation and Setup (Section 2.1.5)

Getting Started with CodeFluent Entities (Section 2.1.6)

2.1.1 Features

Model-Driven Software Factory

Modular Target Architectures Support

¢ Allows multi-architecture without additional cost
o Rich client (client/server architecture)

e Web ASP.NET application (n-tier architecture)

e Web SharePoint application (n-tier architecture)
¢ Smart Client application (n-tier architecture)
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Integrated template engine

Code generation for text based languages

Template caching for an increased generation performance
100% reusable template engine

Integrable as an MsBuild Task

Exclusive Microsoft's RTF support. Allows direct Microsoft Word ® (all versions) editing for creating reports
templates

Internationalization

Dynamic localization of properties in the persistence layer
Multilingual ready for all parts of the application
.NET standard resource model support

Migration scenarios

Database importer for existing SQL Server databases

Database importer for existing Access databases. Existing OLEODbject are exported and transformed into
CodeFluent blobs.

Database importer for existing Oracle Server databases

Database importer for existing OLEDB Server databases (if the OLEDB provider supports the OLEDB schemas
interface)

Database importer for existing SQL Compact Edition databases

Sparx Systems Enterprise Architect ® importer for existing UML projects
XMI 2.x importer for existing UML projects

ADO.NET Entity Framework importer for existing mapping projects

Tooling

Client Console
MSBuild integrable with a provided Task

Microsoft Visual Studio ® 2003, 2005, 2008, 2010 integrable. CodeFluent Entities Modeler Tool (GUI - in
beta) is fully integrated with Visual Studio ® 2008 and 2010.

Easy preprocessing on the CodeFluent Xml model

Generated files are easily debuggable for an increased productivity (Reflection mechanism is not used)
CodeFluent is itself a 100% reusable API

Source controllers and collaborative tools are supported

CodeFluent models can be split in parts to favour collaborative work

Persistence and Storage Layer

[ ]
Persistence
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Microsoft SQL Server ® 2000, 2005, 2008

Oracle Database 9,10,11 support

Customizable naming convention for tables and stored procedure generation
Automatic generation of tables

Automatic generation of stored procedures, including custom ones

Automatic generation of keys (primary, secondary, foreign)

Automatic generation of indexes

Automatic generation of views

Automatic generation of schemas (users)

Automatic generation of dynamic server side SQL for multi criteria search procedures
Manual (ADO.Net) or implicit (TransactionScope) transaction support

Integrated concurrency management (RowVersion) for easier disconnected mode or SOA support
RowGuidCol support in SQL Server for replication scenarios

Automatic stored procedure generation using integrated CFQL query language
Database differential engine for continuous generation and build support

Object-Relational Continuity

Support for standard relational patterns (1:M, M:1, M:M relations, inheritance, associations)

Extensive keying support (Guid, integer, strings, entities, composite keys)

Fully hierarchical model (including relationships generation)

Full support for enumerations values on all layers, from .NET to persistence layer, WCF, serialization, etc.

Integrated query language ("CFQL") for easy custom stored procedure generation, independent from the
target relational database system

Automatic Binary Large Object (file, document, images, videos...) easy handling, with streaming
Automatic paging support (client and server)

Automatic sorting support (client and server)

Automatic generation of LINQ to SQL attributes

Persistence code is not generated dynamically, to ease debugging and favor testability of the solution

Middle-Tier Layer

Business Object Model Layer

Support for standard OOP patterns (collections, generics, inheritance)

Fully hierarchical model (including relationships generation)

Code Generation (supports C# and VB.Net)

Lightweight entities (struct and views) support

Automatic caching support

Support for Winforms automatic binding (INotifyPropertyChanged, IBindingList, IList)

Support for WPF automatic binding (INotifyPropertyChanged, INotifyCollectionChanged, IBindingList)
Support for Winforms and WPF 3.5 automatic validation (IDataErrorInfo)

Support for ICloneable, IComparable, IEquatable, IList, ICollection, IDictionary and their generic equivalent
interfaces

Service layer (WCF) support
XML serialization (XmlSerializer) support
Property validation support (StringValidate, RegularExpressionValidate, CompareValidate, ObjectValidate,
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CustomValidate, ...), with error collections, and specific end-user oriented and localizable messages
Generated model extensible with partial classes or snippet code integrated in the model

Custom external business rule integration

Integration of ILOG Rules for .NET ® as a business rule engine

Integration of custom .NET Assemblies as a business rule engine

Integration of script engines (VBScript, JScript, ...) as a business rule engine

Not based on .NET Framework Reflection mechanisms

POCO support, no base class needed

Service Object Model Layer

Automatic generation of Windows Communication Framework (WCF) facades, server side

A generic Windows WCEF service host is provided, for all Windows versions, so you will not have to write
specific Windows services to host your WCF services

Complete support for WCF extensive configuration capabilities (no specific constraints on bindings, ...)

Automatic generation of an embedded Background Intelligent Transfer Service (BITS) server for large binary
objects (BLOB) upload and download

Support for client and server inprocess debugging (without an external host server process)
Automatic generation of a specific enhanced WCF proxy (optional, as standard proxy generation is still fully
supported) on the client side, for an object oriented approach continuity:

No need for metadata (mex). Saves network bandwidth

Automatic generation of custom business rules on the client, if needed

Automatic generation of validation rules on the client, if needed

Support for WPF automatic binding (INotifyPropertyChanged, INotifyCollectionChanged)

Support for WPF automatic validation (IDataErrorInfo)

Support for WCF streaming for large binary objects (BLOB)

Support for automatic asynchronous paged mode for large size collections

Web Service Layer (ASMX)

Automatic generation of ASMX type web service facades
Automatic generation of custom methods and business rules

User Interface Layer

Web Layer

Automatic ASP.NET custom controls CodeDom generation

Full multilingual support

Automatic CSS based Web Site creation and deployment

Template based generation (using Integrated template engine)

Exclusive Excel and Access ® offline editing & over-the-web synchronization feature (HTTP/HTTPS)

Automatic generation of fully 100% functional ASP.Net MembershipProvider, RoleProvider and
ProfileProvider based on model entities

Support of ObjectDataSource, GridView, DetailsView, FormView, ... classes
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Reusable generic ASP.NET controls provided: BooleanControl, CompareControl, CaptchaControl,
CountryDataSource, ...

Automatic generation of an embedded Background Intelligent Transfer Service (BITS) server for large binary
objects (BLOB) upload and download. No need for IIS.

Office Applications Layer

Exclusive Excel 2003, 2007 and 2010 (32-bit and 64-bit) ® offline editing & over-the-web synchronization
feature (HTTP)

Exclusive Access 2007 and 2010 ® over-the-web synchronization feature (HTTP)
Support of IIS or WCF (3.5 or higher) as the backend. IIS is not needed if WCF is chosen

SharePoint WebParts Layer

(Requires a separate licence)

Automatic SharePoint (WSS3, MOSS 2007 and MOSS 2010) custom web parts generation
Automatic generation of Grid, Forms, in read and edit mode

Server side paging

Server side sorting

Custom rendering support

Multilingual support

SharePoint CSS themes support

Authorization support, based on ASP.Net MembershipProvider, RoleProvider and ProfileProvider in the
SharePoint context

Forms and columns layout editing at runtime for power users (Shared webparts)

Silverlight Layer

Automatic generation of a complete remote object model to ease development and support, based on the exact
same source as the WCF enhanced proxy layer (see Service Model Layer above)

Automatic generation of custom business rules on the client, if needed
Automatic generation of validation rules on the client, if needed
Support for WPF/E automatic binding (INotifyPropertyChanged, INotifyCollectionChanged)

Dynamic generation of asynchronous interfaces (per Silverlight "asynchronous-only" rule), but a synchronous
usage pattern is proposed, to accelerate Silverlight development

2.1.2 Product Editions
This topic describes the different CodeFluent Entities product editions and licensing conditions.

No license is needed for the runtime as a user of a CodeFluent-built application. A CodeFluent license is required
either to generate CodeFluent Entities components from a model or to manipulate CodeFluent Entities generated
components as a developer.

CodeFluent Entities Editions

CodeFluent Entities is available under the following editions :

29

e Personal edition is full-featured, but only allowed for personal and non-commercial use. It can also be used as

a trial version for commercial use.
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Professional edition is full-featured, allowed for commercial use, but generation is limited to models up to 30
entities.

Enterprise edition is full-featured, allowed for commercial use, but generation is limited to models up to 100
entities.

Ultimate edition is full-featured, allowed for commercial use, and not limited in model complexity or size.

2.1.3 Requirements

This topic describes software and hardware minimum requirements for using CodeFluent Entities.

Hardware requirements

Requirement
Processor

RAM

Hard Disk Space
Operating System

Software requirements

CodeFluent Entities

Component

All components

Value
1 GHz
1GB
100 MB

Windows ® 2000 SP4, Windows ® XP SP2, Windows ® Vista, Windows
® 7, Windows ® Server 2003, Windows ® Server 2008

Both 32-bit and 64-bit OSes supported.

Requirement

NET Framework ®

Note: target artifacts can be produced for

any system.

SQL Server Producer
SQL Server Importer

Oracle Server Producer

Oracle Server Importer

Access / Jet Importer
SharePoint Producer

Office Lists Producer

Microsoft SQL Server ®

Oracle Database ® and Oracle
Client libraries (OCI).

ODP.Net is mandatory for Oracle
Producer.

(MDB driver - installed with
Windows)

SharePoint ® Services

Microsoft Excel ® (Client)
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Supported Version

2.0, 3.X, 4.0

2000 (*), 2005, 2008,
2008 R2

& Note: Support for
SQL Server 2000 has
ended on June 30th
2011.

Server: 9, 10, 11

Client (OCI + ODP.Net):
11.X

Access 2000 or higher /
Jet 4 or higher

WSS 3, MOSS 2007,
SharePoint 2010

Read Only mode: 97,
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2000, XP

Synchronized mode:
2003, 2007, 2010 (32-bit

or 64-bit)

Office Lists Producer Microsoft Access ® (Client) Synchronized mode:
2007, 2010 (32-bit or 64-
bit)

Object Model Caching with Microsoft Microsoft Enterprise Library 2,3, 4

Enterprise Library (optional)

Integration with Microsoft Visual Studio Microsoft Visual Studio ® 2005, 2008, 2010

(optional)

ASP.NET Web Producer, Web Services 1.0 Internet Information Services ® 6.0, 7.0, 7.5

Producer, (I1IS) ~

. . . . . [ Note: The 7.0 and

Office Lists Producer Microsoft Visual Studio Web 7.5 versions must

Development Server e
Management
Compatibility feature
activated to fully
leverage those
producers.

Generating automatically the SQL Server Database

Generation of the SQL Server objects relies on the Microsoft SQL Distributed Management Objects (SQL
DMO) technologies. Those 32-bit components are installed when installing complete versions of Microsoft
Visual Studio. Consequently, if you're running an Express edition of Visual Studio you might not have those
components. To use the CodeFluent Entities automated generation feature for SQL Server in such environments,
it's possible to install those components by installing the Microsoft SQL Server 2008 Feature Pack
available here.

4 Note: The SQL-DMO dependency is planned to be removed towards 2012 - Q1.

Compiling automatically the generated source code

Compilation can be done manually by developers, by external tools such as Visual Studio, or automatically
handled by CodeFluent, right after the source code was generated. In order to benefit from the CodeFluent
Entities automated compilation feature, the .NET Framework must be installed as well as Microsoft Visual Studio
or the Windows SDK.

[ Note: In order to compile sources, CodeFluent Entities needs the standard .NET Assembly Linker (AL.exe)
provided by Microsoft. The Assembly Linker is be shipped with Microsoft Visual Studio or the .NET
Framework SDK.

2.1.4 Support

Training

SoftFluent has a training team to help you support you in your projects involving CodeFluent skills.

For more information go to the following link: http://www.softfluent.com/community-support/consulting

Consulting
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SoftFluent has a consulting team to help you support you in your projects.

For more information go to the following link: http://www.softfluent.com/community-support/consulting

Online Help

An online version of this documentation is also available at this address:
http://www.softfluent.com/documentation/

Customer Support

If you have a question that is not answered in the CodeFluent documentation, or a suggestion on the product, please
contact us on our forums: http://forums.softfluent.com/

If you'd like to report a technical problem, please contact our mail support: support@softfluent.com

2.1.5 Installation and Setup

This section contains information on how to retrieve CodeFluent Entities and manage a CodeFluent Entities build
on your computer.

In This Section

Download CodeFluent Entities (Section 2.1.5.1)

Information about how to retrieve the latest CodeFluent Entities build.

CodeFluent Entities Core Edition (Section 2.1.5.2)

Information on how to install and uninstall CodeFluent Entities Core Edition.

CodeFluent Entities Modeler Edition (Section 2.1.5.3)

Information on how to install and uninstall CodeFluent Entities Modeler Editions (standalone and Visual Studio
integrated).

Activating CodeFluent Entities (Section 2.1.5.4)

Information on how to activate CodeFluent Entities (applies to all editions).

2.1.5.1 Download CodeFluent Entities

First Install

You can retrieve the latest officially approved version of CodeFluent Entities from the SoftFluent web site:
http://www.softfluent.com/products/codefluent-entities/download

To access this page you need to be registered in the SoftFluent Community, and you need to be logged-in using this
community account.

On the Account page, you'll find information relative to your account as well as all your available CodeFluent
Entities product and its corresponding license key.

Each product contains a download link which lets you retrieve the latest version (a.k.a. build) of the product.

& Note: CodeFluent Entities is shipped into a ZIP archive which contains both editions of the product: the core
and modeler editions.

Copyright © 2011 SoftFluent S.A.S. All Rights Reserved.


http://www.softfluent.com/community-support/consulting
http://www.softfluent.com/documentation/
http://forums.softfluent.com/
mailto:support@softfluent.com
http://www.softfluent.com/products/codefluent-entities/download
http://www.softfluent.com/account

CodeFluent Entities Documentation 33

Use the CodeFluent Entities Core Edition setup to install the core edition only (no Visual Studio
integration), whereas you can use the CodeFluent Entities Modeler Edition setup which installs both
(Visual Studio integration and command line support).

Upgrading

Once you installed a version of CodeFluent Entities, you'll then be able to either:

keep on using the download page to download newer official builds,

use the SoftFluent Licensing Client (installed with CodeFluent Entities) to download newer official builds or
specific builds, including the latest ones with new features and bug fixes.

Using the SoftFluent Licensing Client (available in your installation directory, SoftFluent.Licensing.Client.exe)
you'll be able to download specific builds (even non validated ones such as betas), and view changes included in a
build (corrections, new features, etc.).

2.1.5.2 CodeFluent Entities Core Edition

This section contains information on how to install and uninstall CodeFluent Entities Core Edition.

The core edition refers to the CodeFluent Meta Compiler (Section 2.2.1) without Microsoft Visual Studio
integration. Eventhough you don't have a designer in Visual Studio to draw entities, properties, relationships, etc.,
you can use Visual Studio to edit CodeFluent Entities models which are plain-old XML files.

The builder tool can then be used in command line by passing the XML model as a parameter.

Check-out this section for installation related matters.

In This Section

Install CodeFluent Entities Core Edition (Section 2.1.5.2.1)
Uninstall CodeFluent Entities Core Edition (Section 2.1.5.2.2)

Use Different builds of CodeFluent Entities Side-By-Side (Section 2.1.5.2.3)

2.1.5.2.1 Install CodeFluent Entities Core Edition

First, you need to download the CodeFluent Entities Core Edition setup installer (see Download CodeFluent
Entities (Section 2.1.5.1) for more information).

[ Note: Although it's not required at runtime, the installer requires Microsoft Document Explorer 2008
to be installed on the machine.

CodeFluent Entities Core Edition setup starts with the Welcome to the CodeFluent Setup Wizard dialog box.
Press the button Next to initialize the installation.

i CodeFluent 1.5 - Build 020128 Setup

&. T;u;;.,t Welcome to the CodeFluent 1.5 - Build
020128 Setup Wizard

The Setup Wizard will install CodeFluent 1.5 - Build 020123
an your compuker, Click Mext bo continue or Cancel to exik

Fhm Sk Wlim -
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LS JTLUp WWsal J,

Eiack  Mext | [ Cancel

Then on the End-User License Agreement dialog box, check the I accept the terms in the License
Agreement check box and press the button Next.

i& CodeFluent 1.5 - Build 020128 Setup

End-User License Agreement r
Please read the following license agreement carefully

END-USER LICENSE AGREEMENT

[

IMPORTANT-READ CAREFULLY: BY INSTALLING OR USING THE
SOFTWARE THAT ACCOMPANIES THIS END USER LICENSE
AGREEMENT {“EULA™) OR ANY ADDITIONAL COMPONENTS
THEREOF {“SOFTWARE™}, YOU AGREE TO BE BOUND BY THE
TERMS OF THIS EULA. IF YOU DG NOT AGREE TGO THE TERMS OF
THIS EULA, YOU MAY NOT USE THE SOFTWARE.

THIS SOFTWARF NOFS NOT SEND ANY SUCH INFORMATION b

[+]1 accept the terms in the License Agresment

[ Erint ] [ Back ” Mexk ] [ Cancel

Then on the Choose Setup Type dialog box, press the button corresponding to the installation type you're
interested in.

{ Note: The complete button installs the CodeFluent Architect edition

i& CodeFluent 1.5 - Build 020128 Setup

Choose Setup Type

Choose the setup bype that best suiks wour needs
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Typical i

Installs the most common program Features, Recommended For mosk users.

[ Zuskom ]

Allows users bo choose which program features will be installed and where
they will be installed. Recommended for adwvanced users,

[ Complete ]

&l program features will be installed, Requires the mosk disk space.,

Then on the Ready to install CodeFluent dialog box, press the button Install to start the installation.

i& CodeFluent 1.5 - Build 020128 Setup

Ready to install CodeFluent 1.5 - Build 020128 l’ﬂ;

Click Install ko beqgin the installation, Click Back ko review or change any af saur
installation settings. Click Cancel to exit the wizard,

[ Back ]| Install | [ Cancel ]

Wait for the installation to proceed. Once completed, you will see the Completed Setup Wizard dialog box.
Press the Finish button to end the installation.

i CodeFluent 1.5 - Build 020128 Setup

i
L o AL
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7 Fluent Completed the CodeFluent 1.5 - Build
020128 Setup Wizard

lick the Finish button to exit the Sebup Wizard.

Eiack . Finish Cancel

Once the installation has completed, the CodeFluent current directory contains the following components:

the CodeFluent tools (Section 2.2): CodeFluent.[...].exe
the CodeFluent producers (Section 2.3.2) assemblies: CodeFluent.Producers.[...].dll
the CodeFluent runtime assemblies: CodeFluent.Runtime.|...].dll

& C:\Program Files\SoftFluent\CodeF luent\Current | E
Fle Edi Wew Favorites Tods  Help ar
@Bu:t - i ? 7 | Sasrch : Falders = ¥ x n -

.'"J.ll:'-.-.vi_'] Py am FlesiSoftFusnd CodeFlusns Current v B
L) Templates ] caderiuent Producers. Codetiom.d] | %] cadeRiuert Runime Rules, tag.dl
anﬂthent.Euid.ere iﬂfndeFIL:rt.Pmd.l:Hs.Clﬂicu.dl |8 CodeFlusrk Funtme, Web.dl
@Cn!fhmt.]mmrt.exe | %] codeFluent Producers. ServiceModel.dl | %] quickzraph.di
Lniﬁ-hmt.Hurtm.bcrucu-bs:.cm iﬂmd:Flmrt.rPudJcm.bquw.dl | %] uckiGraph, wnGraptie dl
[¥] codeFhuent View.ex= | %] codeFiuent Producers.Sqtierver Dmadl |8 WinGraphiiz.di
ﬂtﬂ:fhmt.]mmrtﬂ’s.ﬁlﬁww.dl iﬁlc;:-da-ﬁmrt.h-'ud.ucets.webﬁba.dl gﬁ'CndaHmrt.Ducumrta‘:m.Raferers:a.ch'n
| %] CodeFent Model. Comman,di | %] odeFient furtime Compreession, ol & mab@saftfuent, com icense
%] codeFhuent Medel. di [ ] codeFluent Rurtime.di Eleivars bat
%] codesluent. Model.Ni.dl %] codeFluent Purtime Jszol.dl B cadeFAuant.Buid, exe bufd.sml
| %] Codefluent Producers. Cache dI iﬂiuchlwrt-Rurﬁmnﬁffirc-l:ll & CadeFlusrt Rurdme, <ml

2.1.5.2.2 Uninstall CodeFluent Entities Core Edition

This topic explains how to uninstall a CodeFluent Entities build from your computer.

First, launch the Add or Remove Programs console panel. Then in this panel, select the CodeFluent
Entities build you want to uninstall. In the following screenshot the CodeFluent Build 020222 was selected.
Finally, press the Remove button to uninstall this build from your computer.

B Add or Remove Programs

o |
\tﬁj—j Currenty installed programs and updstes: [#] Show updates Sort by: | Name R
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LSl [ CodeFluent 1.5 - Build 020222
Remorve
Programs Chck here For support information.
,_;\_E To change this program or remove ik from your computer, chck Chamoe or Remonve,
Ak News :
Programs & CodeFluent. Desigrer Sze 0.60MB
_-] Compatibilke descendante de Microsoft SOL Server 2005 Size 27, 26MB
E E‘} Compatibilty Pack For the 2007 Office system Sze  152.00MB
AddRemove
Windows E!-:., Update For Office 2007 (KB934303) Installed On 682007
S L' Security Update for Office 2007 (KE934062) Tnstalled On  6Jaf2007
@ '3 Update For Office 2007 (KBI34395) Tnstalled On  6/13/2007
- B4 Update For Office 2007 (KB934390) Installed On - 6/13/2007
rogram
Aecess and '_"} Update For Office 2007 (KB934391) Installed On 6132007
Defaults
'3 Security Update for Office 2007 (kB336514) Instalied On 7[11/2007
3 Security Update for the 2007 Microsoft Office System (KBI36960) Installed On 8/15/2007
§5) Conexant HDA D10 MDC ¥.92 Madem Sze  055MB &
' Note: You can also repair a CodeFluent Entities installation. Doing so will re-install the selected build
and update the Current directory, even if a newer build is installed.

2.1.5.2.3 Use Different builds of CodeFluent Entities Side-By-Side

This topic explains how to use different builds of CodeFluent on your computer.
The latest installed build of CodeFluent is installed in the following directories :

o the CodeFluent current directory: %ProgramFiles%\SoftFluent\CodeFluent\Current

o the directory corresponding to the installed build
number: %ProgramFiles%\SoftFluent\CodeFluent\[BuildNumber].

Every installed build of CodeFluent is located in the directory

%ProgramFiles%)\SoftFluent\CodeFluent\[BuildNumber] where [BuildNumber] is the actual build
number. A CodeFluent build number is coded yymmdd where yy is the number of years since 2006, mm is the month
and dd is the day, for example the build number 011213 is dated December 13, 2007.

& C:\WProgram Files\SoftFluent\CodeFluent

File Edit ‘“iew Favorites Tooks Help

@Bud& L <> | 'r /- Search i Folders

- Addeess |1 CAProgram Filesi SoftFiuent| CodeFluers

¥ X 9 [@)-

EEX
*

TE

o ¢ W W

011031 011138 011213 020102 020128

J

Current

020207

ol W W

20219

20zzz

Each time you install a build, the Current directory is updated with the contents of the current installation. In fact, it's
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a simple copy of the current [BuildNumber] folder.
2.1.5.3 CodeFluent Entities Modeler Edition

This section contains information on how to install and uninstall CodeFluent Entities Modeler Edition.

The modeler edition refers to the edition shipping the CodeFluent Entities Modeler (Section 2.2.2) which is a
designer integrated into Microsoft Visual Studio 2008/2010. Moreover, the CodeFluent Meta Compiler
(Section 2.2.1), shipped with the core edition, is also shipped by this edition.

In This Section

Install CodeFluent Entities Modeler Edition (Section 2.1.5.3.1)
Uninstall CodeFluent Entities Modeler Edition (Section 2.1.5.3.2)

2.1.5.3.1 Install CodeFluent Entities Modeler Edition

First, you need to download the CodeFluent Entities Modeler Edition setup (see Download CodeFluent
Entities (Section 2.1.5.1) for more information).

The setup is named as: CodeFluentEntitiesModelerSetup.2010.[platform].[Version].msi.

Double-clicking on this setup will launch the installation process:

E Note: The following screenshots were done with the 40709 build, however upper builds also follow the
same process.

| e 5
15! CodeFluent Entities 2010 - Build L=

Welcome to the CodeFluent Entities 2010
- Build 040709 Setup Wizard

The Setup Wizard will install CodeFluent Entities 2010 - Build
040709 on your computer, Click Mext to continue or Cancel
to exit the Setup Wizard.

Click Next to get to the next screen.

"

15 CodeFluent Entities 2010 - Build mom|
| End-User License Agreement A 4
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% 0,
Please read the following license agreement carefully

END-USER LICENSE AGREEMENT -

IMPORTANT-READ CAREFULLY: BY INSTALLING OR USING THE
SOFTWARE THAT ACCOMPANIES THIS END USER LICENSE
AGREEMENT (“EULA™) OR ANY ADDITIONAL COMPONENTS
THEREOF (“SOFTWARE™), YOU AGREE TO BE BOUND BY THE
TERMS OF THIS EULA. IF YOU DO NOT AGREE TO THE TERMS5 OF
THIS EULA, YOU MAY NOT USE THE SOFTWARE.

THIS SOFTWARF NOFS NOT SFND ANY SHCH INFORMATION 2

[V]I accept the terms in the License Agreement:

Print ] [ Back ][ Mext ] [ Cancel

Accept the End-User License Agreement and click Next. On the next screen you'll be able to select the desired
Modeler components you want to install:

3 B
%) CodeFluent Entities 2010 - Build 040709 sm_blﬂlg

Custom Setup
Select the way you want features to be installed.

Click the icons in the tree below to change the way features will be installed.

CodeFluent Runtime Components CodeFluent Runtime Components
are required for using components
generated by CodeFluent. You

Visual Shudio Intearation need at least a professional license
g to use them.

- ED v | Visual Studio 2008 Integra|  11ic faatre requires 3368KB on
{ (= - | Visual Studio 2010 II'ItEgFE yaur hard drive.

[ b

C:'\Program Files (x88)\softFluent\CodeFluent),

| (oskusmee | |

Please note that you can choose to integrate into Microsoft Visual Studio 2008, Microsoft Visual Studio 2010 or
both. By default, the setup installs the Modeler in both versions. If you don't want to integrate into one of your
Visual Studios, click on the feature icon and disable the one you don't want.

Once you selected what you want and where you want it, click Next, and you'll get to an intermediate screen
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which by clicking Next again will actually launch the deployment:

14! CodeFluent Entities 2010 - Build 040709 Sety,

Welcome to the CodeFluent Entities 2010
- Build 040709 Setup Wizard

The Setup Wizard will install CodeFluent Entities 2010 - Build
040709 on your computer. Click Next to continue or Cancel
to exit the Setup Wizard.

The setup is now deploying and configuring all components:

4 CodeFluent Entities 2010 - Build

Installing CodeFluent Entities 2010 - Build 040709

Flease wait while the Setup Wizard installs CodeFluent Entities 2010 - Build 040709,

Status:  Copying new files
— e

Upon a successful deployment, setup will display the following screen:
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Build

Completed the CodeFluent Entities 2010
- Build 040709 Setup Wizard

Click the Finish button to exit the Setup Wizard.

Cancel

2.1.5.3.2 Uninstall CodeFluent Entities Modeler Edition

Uninstalling the CodeFluent Entities Modeler can be done in the Control Panel from the Add or Remove
Programs on XP or the Programs and Features panel on Vista and 7.

Open the panel and look for CodeFluent Entities 2010 - Build [Build Version], select it and right-click on it to
open the following contextual menu:

PR

’ '- [ & Corersl Panel & &l Corerol PanslBems » Programs and Festuras - Search Progrars and Features =)

Cantmol Penel Home:

Uninstall or chiange a program

View installad updates To urinstall & program, select it from the list snd then click Unirstall, Chenge. or Repair

'\_‘ﬂ Tuen Winddws feslures on o
off

Organize = Uninstal  Change  Repair =~ g
Imstall 2 program from the x |
nEtwnrk Heme Publisher Instalied Om  Siz *
f_-. Agkipro SyrilaaEdilor w2 00283 For Weidorss Forms Actipre Sollwane LLC ZEMLXIN0 ||z
IV adobe Dawnload Manager NS Micrnsystems Lbd, 005 xmn
B 2deiae Flash Player 10 Pluge Adohe Systems Incorporated 007X
'.ﬂ.dm!R!:dHBJA Adobe Systems Incomporeted i =R Rl
EndaFIu:nt Entities 2020 - Build 40702 CmbLloant LA 5, 2000772000
2 CoéaFluent Drtities Care Cdition - Duitd 040106 Uninstall £ 5AS, 019/07/2000
(4 CodeFluent Entities Care Edition - Build 040330 Change t R85 300372000

CoceFluent Entities Core Edibon - Buid G301
L'udrFIuer!t Embities Cone Editian - Buikd 030505

b 545, 29/04,2000
L 545, 24052000

Hepair

E oceFluent Eanibes Cone Bdiban - Buie 030604 sSoltFluent 585, BN XTI
:Lndl:FIuent Extibies Cone Edibon - Buid 830704 SoftFluent 4.5, 0000 i
B Crystal Repars Basic for Visuad Stadic 2008 Business Objects 02
] _-jl:ryml Repaorts Basic Runtirme for Wisual Studic 2008 (i) Business Ohbjects 040 2080 .

M e . eon - n -
1|y n d -

-'; SoftFluert S.A.5. Product version: 2040008433 Sippart ek hip e codeflisento nbdies.com
Help link: i fww codelluent.,, Update informetions hifpdOevweycodefluerte nldies com

Click Uninstall to remove the Modeler from your computer.
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2.1.5.4 Activating CodeFluent Entities

Overview

The activation process is required:

e at each new build,

o per user (in the Windows login sense),

¢ on each license data change (maximum number of entities, expiration date), so changes are taken into
account.

Typing-in the product key is compulsory:

o the very first time you run the product,

o for each user (again, in a Windows login sense)

Other than that, if a user already activated once for a given Windows account, the activation process is automatic,
provided the automatic activation mode was selected and that the user has a valid internet connection.

' Note: Automatic activation mode is the default mode. You can modify this setting using the SoftFluent
Licensing tool (SoftFluent.Licensing.Client.exe in the installation directory), and opening File > Options
dialog, and in the Internet section, check the Manual mode (unchecked by default).

Likewise, use this menu to configure a specific proxy if a proxy different from the one used by Internet
Explorer is needed.

See the Troubleshooting Connection Problems paragraph for more information.

Activating the Product for the First Time

On the very first execution of CodeFluent Entities a dialog will pop-up asking you to activate the product.

. — —
_-,¢=d-'w=lmnf=w-- L]

gt your pradics oy for scivaton

Yoy oo fnd yoar prodhucs owy My conraod b e ol lusen pda
¥ o Pl Becon. of i e e SoRFlolet B Sorl 1 pou

Thie prodiet ey ok b Baa

O KGR OO e M

Preiebiot My dmitens well be added putoratcnlly

Lanod

To activate the product:

e go to http://www.softfluent.com and log-in using your account,
¢ on the Account page, copy the product key corresponding to the product,
o paste the key in the dialog box, and click Activate.

Refreshing an Activation
If ever information on the server side regarding your license changed (maximum number of entities, expiration
date), you'll have to refresh your activation.

A common scenario is if ever you upgrade your license from one version to another (e.g. professional to
enterprise, enterprise to unlimited, etc.), you'll need to refresh your activation so the new license information is
actually taken into account.
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In your installation directory, an executable is shipped to allow users to manage their licensing and activation
matters. This program is the SoftFluent.Licensing.Client.exe program.

To refresh an activation:

Select an installed build in the tree view,
Click the Refresh Activation button in the right pane.

Troubleshooting Connection Problems

If for some reason activation does not work as planned, you can use the SoftFluent.Licensing.Client.exe
program (available in the installation directory) which provides extra-capabilities.

Check Connectivity

Using the SoftFluent.Licensing.Client.exe you can ensure CodeFluent Entities can contact our activation
servers. Select Help > Check Connectivity to launch a test.

If this test fails it's probably due to proxy settings or a lack of internet connection.

Supporting Proxies

By default, the licensing client is configured based on your Windows Internet Options (available in the Control
Panel). Therefore, it should support standard internet options including proxies.

However, if ever this does not work automatically, in the File > Options... dialog, you can set-up a specific proxy
configuration.

If the Check Connectivity test still fails, please use Email Activation as described hereunder, since automatic
activation mode can't be used with your configuration.

Email Activation
The default activation process requires an active internet connection so it connect to our servers; this is what we
call the Internet mode.

The internet mode is configured based on your Windows Internet Options (available in the control panel).
Therefore, it should support standard internet options including proxies.

However, in some custom environments the Internet Mode might not be able to contact our activation servers.
For such scenarios an alternative activation mode is available: the Email mode.

[ Note: Email activation is available in the licensing tool version 1.3 and upper. You can check which version
you have by running SoftFluent.Licensing.Client.exe, and then click Help > About.

If you have an older version such as the 1.2.0.0, you can download a new version of the licensing tool here:
http://www.softfluent.com/downloads/sfl/softfluent.license.zip

Overwrite the existing version with the content of the downloaded archive.

Email activation is a two step procedure:

Step 1: Start Product Activation

Run the SoftFluent Licensing tool (SoftFluent.Licensing.Client.exe).

Get in the File > Options menu, and make sure the Email option is selected. Please note that once you have
selected the Email option, activation will always be manual each time you will need to upgrade the product.

Click the "File > Email Activation >#1. Start Product Activation" menu item.

Choose the product you want to activate, press OK.

Enter the product key, press Activate.

Click on "Create Request File". This will create a licensing request XML file.

If the machine has any email software installed, you can click on "Prepare the email", attach the request file
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and send it. Otherwise send an email with activation @softfluent.com as recipient and the request file attached
to it from another machine such as this one:

A

A

o e

FEEL RN BB WL

Send the email to us and wait for our response. Once you have it, go to step 2.

Step 2: Complete Product Activation

Save the response file attached with our response mail somewhere on the machine's hard disk.
Run the SoftFluent Licensing tool (SoftFluent.Licensing.Client.exe).

Get in the File > Options menu, and make sure the Email option is selected (it should be if you have been
through step 1).

Click the "File > Email Activation > #2. Complete Product Activation" menu item.
Click on "Browse Received File", and select the response file previously saved.
Enter the same product key used during step 1, and press "Activate".

The product should have been activated.

Information collected by the activation process

The following information is collected by the activation process:

Hardware Id
Machine Name
User Name

OS Version
CLR Version

As well as the following indicators:

Interactive Session
Web Session
Remote Session
Virtual Machine

Since the goal of the activation process is to counter piracy, too many activations of the same user key for a too
wide range of changes of these parameters may cause a deadlock. For obvious security reasons of our activation
process, the rules we apply are not intended to be public (as opposed to collected information that are mentioned
above).

Pursuant to the License Agreement, licenses are assigned to physically appointed users, which a standard license
use will not result in blocking. If an abnormal blocking should happen, we'll obviously unlock your license.

It is important to note that this process also protects your liability in case of license key theft or illegal use.
If a key is over-used since hacked, we can disable it and assign a new one.

2.1.6 Getting Started with CodeFluent Entities
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The following articles point to technical resources to get you started developing the kind of application you want.

Moreover, don't forget to check our Tutorials (Section 2.6) section for step by step scenarios.

Desktop Applications

Developing Desktop Applications (Section 2.4.4)

Check-out this section to get started developing Windows desktop applications (rich clients or smart clients)
using CodeFluent Entities.

Web Applications

Developing Web Applications (Section 2.4.5)
Check-out this section to get started developing ASP.NET web applications using CodeFluent Entities.

Silverlight Applications

Developing Silverlight Applications (Section 2.4.6)
Check-out this section to get started developing Silverlight applications using CodeFluent Entities.

SharePoint Applications

Developing SharePoint Applications (Section 2.4.8)

Check-out this section to get started developing SharePoint applications using CodeFluent Entities.

Oracle Database Applications

Developing . NET Applications With Oracle Database (Section 2.4.9)

Check-out this section to get started developing .NET applications using an Oracle Database with CodeFluent
Entities.

Misc

Besides those kick-start articles, this documentation contains several other sections to help you:
The Development Tools (Section 2.2) section provides information on each of the tools provided with
CodeFluent Entities,

The Architect Guide (Section 2.3) section contains detailed information of all CodeFluent Entities
concepts (Entities, Properties, Rules, Producers, etc.) you'll need to design your application,

The Developer Guide (Section 2.4) section provides practical information, so developers can implement
specific features such as localization, paging, sorting and many more!

The Reference Guide (Section 2.5) section contains an exhaustive list of elements and their attributes
available in the product,

The Tutorials (Section 2.6) section contains step by step examples to create applications using CodeFluent
Entities,

The Technical Articles (Section 2.7) section contains technical articles related to the product,
The White Papers (Section 2.8) section regroups official SoftFluent white papers.
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2.2 Development Tools

This section describes the tools that are shipped with CodeFluent. Those tools are located in the CodeFluent
current directory: %ProgramFiles%\SoftFluent\CodeFluent\Current.

A CodeFluent typical project can iterate through the following steps by using the CodeFluent product tools :
¢ Step o0 : IMPORTING = Import the CodeFluent design model from an existing database;
e Step 1: MODELING = Edit the CodeFluent design model;
e Step 2 : EXPLORING = Explore the CodeFluent design model;
e Step 3 : PRODUCING = Produce output.

' Note: The import step (step 0) is optional, you do not need to import from an existent database to start a
project with CodeFluent. You can directly start at Step 1: Modeling.

CodeF|uent
hMeta Model
Explorer

XML Lade k| ane
EDITOR - . KL Madel

N

CadeF|uarnt
Database
Importer

SELL Servern

Database

In This Section

CodeFluent Builder (Section 2.2.1)

A command line tool to design your application.

CodeFluent Entities Modeler (Section 2.2.2)

A user interface, integrated into Microsoft Visual Studio, to design your application.

CodeFluent Importer (Section 2.2.3)

A command line tool to import an existing database to a CodeFluent model.

CodeFluent Meta Model Explorer (Section 2.2.4)
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A GUI tool to explore the in-memory representation CodeFluent built from a model.

CodeFluent Service Hoster (Section 2.2.5)(Section 2.2.1)

A command line tool to host any services (from Windows services to Windows Communication
Foundation services).

CodeFluent Variables Script (Section 2.2.6)

A Microsoft Windows batch files which sets environment variables useful to CodeFluent.
2.2.1 CodeFluent Meta Compiler

You can invoke the meta compiler (a.k.a. builder) tool by typing the name of its executable file
(CodeFluent.Build.exe) on the command line. The meta compiler tool generates ready to use components
from a CodeFluent model which defines the business logic of your application as well as the defined producers
which will actually generate the components. To do so, the tool starts by building a meta-model of your business
logic, which will then be translated by each defined producer into platform specific code.

CodeFluent models may contain environment variables (%CF_CURRENT_PATH%,
%CF_TEMPLATES_PATH%, etc.). If those environment variables are missing on your machine the build process
won't complete. In such cases, you must either define the environment variables on your machine, or you must
run cfvars.bat to set the appropriate environment variables to support command line builds. For more
information about cfvars.bat, see CodeFluent Variables Script (Section 2.2.6).

To build from the development environment, see the Microsoft Visual Studio Integration (Section
2.6.1.1) in the Tutorials (Section 2.6), or the Industrializing the Production Process (Section
2.3.2.1.4) article.

The CodeFluent.Build.exe executable is usually located in the SoftFluent\CodeFluent\

[BuildNumber] folder under the program files folder, or in the SoftFluent\CodeFluent\Current folder
under the program files folder, if it's the last installed build. Its location may vary depending on the exact
configuration on any individual computer. Multiple versions of this executable will be present on the computer if
more than one version of CodeFluent is installed on the computer. For more information about such installations,
see Use Different builds of CodeFluent Entities Side-By-Side (Section 2.1.5.2.3).

H Note: CodeFluent.Build.exe is shipped as a 32-bit application. However it runs fine on 64-bit platforms
(in WOW mode) and allows you to create 32-bit and 64-bit applications.

The command line tool accepts the following options:

Option Description

/DoNotProduce Only loads the model

/DisableImports Disable imports

/AutoDisableImports Automatically disable failing imports

/ExtractSchema Extracts CodeFluent.xsd to the current directory

/ExtractSchemaVS8 Extracts CodeFluent.xsd to Visual Studio 2005 Xml schema directory
/ExtractSchemaVSg Extracts CodeFluent.xsd to Visual Studio 2008 Xml schema directory
/ExtractSchemaVS1o Extracts CodeFluent.xsd to Visual Studio 2010 Xml schema directory
/ExtractDefaultApplication Extracts DefaultApplication.xml to the current directory
/DeleteCache Delete default templates cache

/NoFlashOnError Do not flash console on error

/Reports Shows the reporting dialog box

/DoNotCreateReportsOnException Error reports are not created

/DoNotShowReportsOnException  Error reports dialog box is not shown
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/Continuous Does not exit when production is finished

/RunTemplate:<Source>,<Target> Runs the template engine from the source directory path to the target path

Example

This example demonstrates how to use the meta compiler tool to generate layers from the Sample.xml model.
Below is the content of a Generate.bat batch file which launches CodeFluent.Build.exe.

Generate.bat

call "%ProgramFiles%\SoftFluent\CodeFluent\Current\cfvars.bat"
call "%$ProgramFiles%\SoftFluent\CodeFluent\Current\CodeFluent.Build.exe"
Sample.xml

Below is the content of the Sample.xml model which defines a Customer entity, and the Microsoft SQL
Server Producer as well as the Business Object Model Producer.

Model

<!-- Sample.xml -->
<cf:project xmlns:cf="http://www.softfluent.com/codefluent/2005/1"
defaultNamespace="Sample"
defaultKeyPropertyTypeName="int"
defaultConnectionString="server=(local) \SQLEXPRESS;database=
{1};Integrated Security=true">
<!-- Microsoft SQL Server Producer -->
<cf:producer typeName="CodeFluent.Producers.SglServer.SglServerProducer,
CodeFluent.Producers.SglServer">

<configuration targetDirectory="..\Generated\Sqgl" />
</cf:producer>
<!-- Business Object Model Producer -->

<cf:producer typeName="CodeFluent.Producers.CodeDom.CodeDomProducer,
CodeFluent.Producers.CodeDom">

<configuration targetDirectory="..\Generated\Model" outputName="{0}.d1l1l"
/>
</cf:producer>
<!-- Entities -->
<Customer>

<Id typeName="int" />
<FirstName typeName="string" />
<LastName typeName="string" />
</Customer>
</cf:project>

2.2.2 CodeFluent Entities Modeler

The CodeFluent Entities Modeler is a graphical tool to create, modify, build and execute CodeFluent Entities
models. It exists in three versions:

e The Visual Studio 2008 Integrated modeler, shipped only with CodeFluent Entities Modeler Edition
e The Visual Studio 2010 Integrated modeler, shipped only with CodeFluent Entities Modeler Edition.

Here are the main differences between the different modeler versions:

Modeler Type Side by Source Control Xml External CSharp
Side Support Edition Projects Update

Portable Yes No No No

Visual Studio No Yes Yes Yes

Integrated
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CodeFluent Entities Portable Modeler

The portable modeler is for users who don't have Microsoft Visual Studio and wish to view or quickly edit a model.

Since it's not integrated with Visual Studio, and doesn't provide source control support, we do not recommand using
the Portable modeler to develop applications.

To do so, please use the CodeFluent Entities Modeler Edition which provides a Visual Studio integrated user
interface.

CodeFluent Entities Modeler

A GUI tool, integrated into Microsoft Visual Studio, to design your application.

CodeFluent Entities Modeler provides new Visual Studio project type which allows you create CodeFluent Entities
projects where you'll be able to model your application.

Using the modeler you'll be able to use all CodeFluent Entities concepts (Entities, Properties, Rules, Producers, etc.)
through a graphical UL

An overview is available here: CodeFluent Entities Modeler Overview.

2.2.3 CodeFluent Importer

You can invoke the importer tool by typing the name of its executable file (CodeFluent.Build.exe) on the
command line. The importer tool imports existing databases and models (Microsoft SQL Server, Oracle Database,
Microsoft Access, Enterprise Architect, XMI, etc.) to CodeFluent models. For instance, a table will become an entity,
a column a property, and relations between entities will be deduced from keys.

The CodeFluent.Import.exe operates in a two step process:

1. Create an in-memory representation of the source,
2. Create a new CodeFluent model from this in-memory representation.

The class creating an in-memory representation must be defined on the command line. This class is to the
CodeFluent.Importer.exe as a driver is to an operating system. Those "drivers" are available in the
CodeFluent.Importers.Database assembly and the CodeFluent.Importers.SqlServerCe assembly.

Here's how to use the executable:

Useage

Format is CodeFluent.Import <typeName> <config>.xml
Examples:

[target.xml]

CodeFluent.Import "CodeFluent.
CodeFluent.Importers.Database"
CodeFluent.Import "CodeFluent.
CodeFluent.Importers.Database"
CodeFluent.Import "CodeFluent.
CodeFluent.Importers.Database"
CodeFluent.Import "CodeFluent.
CodeFluent.Importers.Database"
CodeFluent.Import "CodeFluent.
CodeFluent.Importers.Database"
CodeFluent.Import "CodeFluent.
CodeFluent.Importers.Database"
CodeFluent.Import "CodeFluent.
CodeFluent.Importers.Database"

Importers.Database.

sgql config.xml

Importers.Database.

ora config.xml

Importers.Database.

ea config.xml

Importers.Database.

acc_config.xml

Importers.Database.

oledb config.xml

Importers.Database.

ea config.xml

Importers.Database.

xmi config.xml

SglServermporter,
OraclelImporter,
EnterpriseArchitectImporter,
AccessImporter,
OleDbImporter,
EnterpriseArchitectImporter,

XmiImporter,

CodeFluent.Import "CodeFluent.Importers.SglServerCelImporter,
CodeFluent.Importers.SglServerCe" sqglce config.xml
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CodeFluent is shipped with the following importers:

Microsoft SQL Server importer,
Microsoft SQL Server CE importer,
Microsoft Access importer,

Oracle Database importer,

OLE DB Importer (to use exclusively with OLEDB providers supporting the IDBSchemaRowset
interface),

Enterprise Architect importer,
XMI importer.
Entity Framework (4.x) importer.

[ Note: CodeFluent Importer tool doesn't import data, it is only intended to import a database schema or model
to a XML file.

How to use the importer

For detailed examples on how to use the importer please refer to the Migration (Section 2.3.6.1) section which
contains examples for each platform.

2.2.4 CodeFluent Meta Model Explorer

The CodeFluent Meta Model Explorer (corresponding to the CodeFluent.View.exe file) is a tool you can use to
explore a CodeFluent model. This allows a developer to navigate through a model as understood by the CodeFluent
Meta Model Engine, before the generation step. This tool allows you to see most of what will be generated, before it is
actually generated:

o Persistence layer concepts: virtual tables, procedures, constraints, and views;

e Business model layer concepts: entities, enumerations, and sets (also known as collections);
o User interface layer concepts: windows, controls, forms.

The following screenshot illustrates a Customer entity viewed in the CodeFluent Meta Model Explorer. The
explorer shows a developer which producers were used, what will be produced from the model. In this case, we can
notice that in the Persistence Layer, a table named Customer and five stored procedures

(Customer_Load, Customer_LoadAll, Customer_LoadByld, Customer_Save and Customer_Delete) will
be produced. The Business Object Model (BOM) will only contain one entity named Customer.

& CodeFluent Meta Model Fxplorer - C:\CodeFluent\Samples\Architect\DesigniMyModel. xm| - HowTo E|E|@
File Yiew Took Help

r. -

= ﬁ,b Business Model Layer Mams Type Size Mudl..
93 Id Syetern. Int32/DbType Int22/UIT ype. Integer Falze

=gl Producess Frathame Syzhern, Sting /Db T ppe. 5 ring/ UL T ype. Test 56 Tae
] CodeFluent Producers SgfServer SqlServer || LasiMame System. StngDbT vpe String/ LT vpe. Text 256 Thue

4] CodeFluent Producess CodeDom CodeDonP)
= |} Persistence Layer
=Ly Mitual Tables
| Cusbomer
= Uk, Vitual Procedues
sk Customes_Delete
s Cusbomer_Load
st Cugbomer_Loaddll
st Cuskomer_LoadByld
sty Customer_Save
# 5 Ul Layer - Applications
+ =] Ul Layer - Forms
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2.2.5 CodeFluent Service Hoster

The CodeFluent Service Hoster is a command line tool used to host services. The CodeFluent Service
Hoster can host standard Windows services as well as Windows Communication Foundation (WCF)

services.

In order to services, the CodeFluent Service Hoster needs the hosted assembly containing the service(s), a

standard .NET configuration file indicating the hoster which service to host and of course the referenced
assemblies used by the hosted assembly.

The hoster can be used in two modes:

¢ a Console mode,

¢ a Windows Service mode.

The Console mode is very useful while developments since it allows the developer to test his services without
having to redundantly install/uninstall the developed service.

The CodeFluent Service Hoster command line tool accepts the following options:

Option

/?

/i

/u
/name:<name>

/displayName:
<dname>

/description: <desc>
/startType:<type>

/user:<name>

/password: <text>
/config:<path>
/dependson:<list>
/k

/t

Description

Display help

Install the Windows Service
Uninstall the Windows Service
The Windows Service Name

The Windows Service Display Name

The Windows Service Description
The Windows Service Start mode, default is Manual

Name of the account under which the Windows Service should run, default is Local
System

Password of the account under which the Windows Service should run
Path to the configuration file

A comma separated list of service to depend on

Kills this process on any exception

Displays traces on the console

Example: Using the CodeFluent Service Hoster in Windows Service

mode

Below is the content of the InstallService.bat batch file which installs the CodeFluent Service Hoster as the
MyServiceName Windows Service.

InstallService.bat

CodeFluent.Runtime.ServiceHost.exe /i /name:MyServiceName
/displayName:MyServiceDisplayName /description:"This service is a WCF services

hoster"

Below is the content of the UninstallService.bat batch file which uninstalls the MyServiceName Windows

Service.
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UninstallService.bat

CodeFluent.Runtime.ServiceHost.exe /u /name:MyServiceName

The result of the CodeFluent Service Hoster installed as a Windows Service is illustrated by the following picture.
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2.2.6 CodeFluent Variables Script

Among tools installed with CodeFluent Entities, there's a batch file named cfvars.bat which enables users to
easily set some environment variables that can ease working with CodeFluent Entities.

By default four variables are defined:

1. CF_CURRENT_PATH: corresponding to the installation folder,
2. CF_TEMPLATES_PATH: corresponding to the Templates folder installed in the installation folder,
3. CF_PATTERNS_PATH: corresponding to the Patterns folder installed in the installation folder,
4. CF_BUILD_NUMBER: corresponding to the current build number.
Even though optional, those variables get very handy in team developments. By using those environment

variables in the model, even if developers have a different installation directory they'll be able to share the same
model.

' Note: In builds upper the 40505, the CF_CURRENT_PATH, CF_TEMPLATES_PATH, and
CF_PATTERNS_PATH are defined at runtime if they aren't set. Else the already configured value is used.

Example of producers using environment variables
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<cf:project xmlns:cf="http://www.softfluent.com/codefluent/2005/1"
defaultNamespace="Sample"
defaultConnectionString="server=(local);database={0}; Integrated
Security=true">
<cf:import path="$%CF_ PATTERNS PATH%\SoftFluent.Localization.xml"
runTemplate="true" step="Methods"/>
(...)
<!-- Produces the services configuration from the server configuration templates
-——>
<cf:producer typeName="CodeFluent.Producers.CodeDom.TemplateProducer,
CodeFluent.Producers.CodeDom">
<cf:configuration sourceDirectory="%CF TEMPLATES PATH%\ServiceModel\Server"
targetDirectory="..\{0}"
outputEncoding="iso-8859-1"
compile="false"/>
</cf:producer>

<!-- Produces the client configuration from the client configuration templates -
->
<cf:producer typeName="CodeFluent.Producers.CodeDom.TemplateProducer,
CodeFluent.Producers.CodeDom">
<cf:configuration sourceDirectory="%CF_TEMPLATES PATH%\ServiceModel\Client"
targetDirectory="..\{0}.WinFormApp"
outputEncoding="iso-8859-1"
compile="false"/>
</cf:producer>
</cf:project>

CF_DEFAULT_PERSISTENCE_SERVER

Another interesting possible environment variable is the CF_DEFAULT_PERSISTENCE_SERVER.
Although not in the cfvars.bat by default, it's a very convenient variable which allows developers to free
themselves from defining a connection string in their models.

By default CodeFluent Entities uses this connection string (where defaultNamespace is the default namespace of
your project):

Default Connection String

Application Name=[DefaultNamespace];server=[PersistenceServer];database=
[DefaultNamespace];Integrated Security=true

If the CF_DEFAULT_PERSISTENCE_SERVER environment variable is set, it is the value used as
[PersistenceServer]. If ever this value isn't specified, the value used is: 127.0.0.1

Using this variable instead of explicitly declaring a connection string in the model allows team members to share
the same model without having them to continually modify the model to make it work on their environment.

2.3 Architect Guide

The Architect Guide section contains detailed information on all CodeFluent Entities concepts (Entities, Properties,
Rules, Producers, Patterns, Methods, etc.) and how they can be used to build an enterprise-class application.

[ Note: Those concepts are used in XML models which can be written by hand or using the Modeler. Either way,
the use and effects stay the same.

In This Manual

Designing (Section 2.3.1.1)

Information about how to design applications with CodeFluent.
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Producers (Section 2.3.2)

Information about CodeFluent producers.

Implementing (on-line documentation)

Information on how to extend generated code.

Advanced Designing (Section 2.3.3)(Section 2.3.1)

Information about advanced designing features such as dynamic designing and patterns.

Migration and Interoperability (Section 2.3.6)

This section documents how to import an existing database to a CodeFluent model in order to migrate or
interoperate with the former application.

2.3.1 Designing

This section provides a quick overview of the structure and schema of CodeFluent design models.

CodeFluent design models can be written in the Free or Normal XML schema form. Even though the global
aspect of the model changes from one form to the other, the structure of it remains the same.

The free form is more unformal and convenient for developers to use since it was conceived to be just as writing
your business concepts with abstraction of the maximum of technical information. For instance, defining a
Customer business concept which has an identifier, a first name, a last name and an e-mail address would be
declared as so:

Entity in the Free Form

<Customer>
<Id typeName="int"/>
<FirstName typeName="string"/>
<LastName typeName="string"/>
<Email typeName="string"/>
</Customer>

On the contrary, the same Customer business concept declared in the normalized form looks like the following:

Entity in the Normal form

<cf:entity name="Customer">
<cf:property name="Id" typeName="int"/>
<cf:property name="FirstName" typeName="string"/>
<cf:property name="LastName" typeName="string"/>
<cf:property name="Email" typeName="string"/>
</cf:entity>

As you can see, the normal form can quickly get heavier than the free form, however it is best suited if you want to
automatically generate CodeFluent models. Accordingly, since the free form is lighter, it's more convenient for a
developer to read and write models in such a form.

[ Note: Microsoft Visual Studio can only provide auto-completion for the normalized form. However,
Normal and Free schema forms can be mixed in a common CodeFluent model and both ways are
completely equivalent to the CodeFluent parser.

Regarding the structure of a model, the first steps is that one needs to declare the root node named
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Project. Inside a Project node, the following nodes can be declared:

Import nodes to import other parts,

Entity nodes representing a business concept of your project,
Enumeration nodes representing a static enumeration of values,
Rule nodes representing business rules at the project level,
Message nodes to declare strings at the project level,

UserType nodes to declare user defined types,

Category nodes to declare UI compartments,

Store nodes to declare Persistence compartments,

Pattern nodes to declare patterns,

Producer nodes to setup producers.

Then inside an Entity node, the following nodes can be declared:

Property nodes to declare properties of your business concept,
Method, Snippet or SetSnippet nodes for methods (which can contain Parameter sub-nodes),
Rule nodes representing a business rule for the current entity,
Message nodes to declare strings at the entity level,
View nodes to declare a view on the current entity (a view can contain ViewProperty sub-nodes),
Instance nodes for entity instances.

[ For more information on Producer nodes, go to the Generating (Section 2.3.2) section.

For more information on Pattern nodes, go to the Aspect Designing (Section 2.3.3) section.

This is a quick overview of possible nodes contained in a CodeFluent and should not be taken as an exhaustive list
of all possible nodes in a CodeFluent model.

To know more on the model structure, possible nodes and their attributes, please refer to the Reference Guide
(Section 2.5).

In This Section

Design model (Section 2.3.1.1)

Information about CodeFluent design concepts, CodeFluent design model and CodeFluent types.

Projects (Section 2.3.1.3)

Information about the Project concept and design model exploration.
[ ]

Entities (Section 2.3.1.3)

Inforfnation about the Entity concept (standard and light), instances, relationships between them (e.g.
inhesitance, composition, or association), how to group entities (into namespaces, schemas, categories or stores),
and finally information about directory entities (e.g. User and Role).

.

Prolzerties (Section 2.3.1.5)

Infoygnation about the Property concept (standard and computed).
o

Enumerations (Section 2.3.1.4.1)

Information about the Enumeration concept.

Metl:lods (Section 2.3.1.6)
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Information about the Method concept: persistence methods such as Load, Search, Count, Delete, as well as
snippets.

Rules (Section 2.3.1.7.4)

Information about the Rule concept.

Views (Section 2.3.1.8)

Information about the View concept.

Messages (Section 2.3.1.9)

Information about the Message concept.

Naming Conventions (Section 2.3.4.1)

Control produced names by using naming conventions.
2.3.1.1 The CodeFluent Model

This section contains information on the CodeFluent model.

It documents global concepts, available CodeFluent types and the design model structure and schema.

In This Section

Design Concepts (Section 2.3.1.1.1)(Section 2.3.1.3)

Information about global concepts manipulated in CodeFluent.

Type System (Section 2.3.1.1.2)(Section 2.3.1.3)

Information about available types.

Reusing .NET Types (Section 2.3.1.1.3)
Explains how to reuse standard .NET types.

Model Structure (Section 2.3.1.1.4)(Section 2.3.1.3)

Information about how a model is structured.

Model Schema (Section 2.3.1.1.5)

Information about the model contents and about the XML free and normal forms.
2.3.1.1.1 Design Concepts

This topic presents CodeFluent modeling concepts:

Software Factory

Global concepts

Object Oriented Programming (OOP) concepts
e Persistence concepts
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User Interface concepts.

Software Factory

CodeFluent is a software factory. A software factory is an industrialization software which applies manufacturing
techniques and principles to software development to mimic the benefits of traditional manufacturing.

Nowadays, most of software developments can be compared to a hand-crafted work which implies that the ratio
development effort / produced software is dramatically lower than an industrialized production. In a hand-
craft.ed development, the craftsman will develop his feature from scratch each time needed which outcomes in a
time waste.

This is a commonly known issue, and a widely spread way to address this issue is developing frameworks.
Instead of developing the feature again and again throughout projects, the feature is made generic and included
in a framework so that this feature becomes reusable. Even though this approach is more productive on the long
term than hand-crafted development, it creates, on a long term, possibly huge, hard to maintain and hard to
evolve frameworks. Moreover, in scenarios where a software development needs one precise feature of the
framework, it will have to drag the whole framework to benefit from the single given feature.

Finally, another solution to tackle the software productiveness issue, is the software factory development mode.
A software factory is a software or a software product line which allows developers to industrialize software
developments based on a software schema. In our case, CodeFluent is a model driven software factory which
based on a model describing an application, will produce 100% functional components. To get back to our
example, the feature is provided by the software factory which, if defined in the model, will be produced in the
output software. This way, software developments are industrialized assuring shorter development cycles, a
higher quality, and avoids dragging complex and/or large frameworks since only the desired features are used.

Comparison between software development modes are summed-up in the following diagram:

Development
Effart & Hand-crafted » mode

« Framework » mode
Framework developmeant

(may last foraver...)

/
|

—
Mumber of Entities
[==Model Size}

Global Concepts

Model Driven Development (MDD): CodeFluent is a model driven software factory, meaning that based
on a model defining your business concepts and the desired technical architecture, CodeFluent will produce
fully functional components. Moreover, CodeFluent is built so you can easily modify and rebuild your
application. Hence, the model remains a core part of the developments. Among other benefits, driving
developments by the CodeFluent model will ensure the model stays in synchronization with developments,
this way providing an accurate, and up-to-date, overview of your software.

Platform Independent Model (PIM): CodeFluent models are platform independent. The architect focuses
on defining the business concepts and desired features.

Platform Specific Model (PSM): nevertheless, CodeFluent models are also platform specific thanks to
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CodeFluent's producer logic. Each producer produces platform specific and optimized code. In addition to the
generated and optimized code, CodeFluent allows software architects to add custom, platform specific, code to
CodeFluent models. This custom code will be inserted in the targeted specific output, thanks to its related
producer.

Object-Relational Mapping (ORM): CodeFluent allows you to create a representation of real-world
concepts that define or influence your software. It includes primary objects (entities) in the system, and
relationships between those objects, the overall providing a logical representation between objects. Those
objects will be produced into persistent objects in the database layer and into CLR objects in the business
layer; and business layer objects are mapped on to the persistence layer objects. The business layer acts as a
virtual object database where changes operated on them will reflect in the persistence layer as well.
Declarative Programming: CodeFluent is a Declarative Programming tool in which a software architect
can define in a readable model of his software. This model is a complete and accurate representation of the
business concepts, rules, and architecture of the software.

Aspect-Oriented Programming (AOP): CodeFluent allows software developers to define aspects of
concepts and their properties regardless of their implementation. For instance, one can declare the aspect of
an e-mail in his model and be assured the generated software, regardless of the technologies used and
throughout all layers, will handle e-mails as defined.

OOP concepts

Entity: a business entity like 'Customer’, 'Order’, 'Cat’, 'Dog/, ...

Lightweight Entity: an entity representing a light object such as non persistent objects, structures, etc. It
can also be mapped to standard .NET types such as the Point structure or views.

Relation: describes the type of relation and cardinality between two entities. The relation can be 1:1, 1:M, M:1
or M:M.

Inheritance: an inheritance relationship describes the relationship between a super-type entity and its sub-
type entities. An entity can have any number of ascendant or descendant entities.

Method: CodeFluent allows the definition of any method (standard C.R.U.D., custom load methods, snippet
methods, external business rules, ...) associated with a given entity. Depending on configured producers, these
methods may (or may not) be exposed as Services. For example, the Web Service producer creates by default a
SOAP operation for every method in the model.

Property: an entity has a defined set of properties. Some properties are inherited from ascendant entities.
Properties are also used as 'connectors' for relations between entities: if the property's type is an entity or the
collection of an entity defined in the CodeFluent model, the property also defines a relation. The cardinality on
this side of the relation is M (Many) if the property's type is a collection, 1 (One) if the property's type is an
entity.

Parameter: every method can have zero to any number of parameters.

View: a view is a read only virtual or logical entity associated with a model entity, composed of view
properties. Each view property is defined by an expression computed on the associated entity. Changing the
data in an entity alters the data shown in the view. Every entity has at least one view, automatically created by
CodeFluent, the Default view. This view's properties matches the entity's properties. At the persistence level, a
view can be generated as a real SQL view.

View Property: a view has a defined set of view properties, just like an entity has a defined set of properties.
View properties have almost the same characteristics as entities properties.

Persistence concepts

These concepts represent a logical database and are used (or not) by producers configured for persistence such as
the SqlServer producer:

Store: every entity in the model is associated with a store. A store is only defined by its name. The store
concept can be used by persistence oriented producers to create multiple databases for one CodeFluent model.
At production time, a store may be associated with a relational database or any other persistence mechanism.
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Database: there is only one database per CodeFluent model. The database contains all tables and procedures.
This concept is not related to relational databases.

Table: a table is a set of data elements (values) that is organized using a model of horizontal rows and vertical
columns.

Column: a column of a table is a set of data values of a particular simple type, one for each row of the table. A
column's type is always a Simple Type (Section 2.3.1.1.2).

Constraint: a constraint defines conditions about a particular table that must remain true while modifying
data in the database. CodeFluent has three types of constraints: Primary Key, Foreign Key, Default and
Unique.

Procedure: a procedure represents a relational database stored procedure. CodeFluent represents
procedures internally using an exclusive technology named SqlDom. One of the most interesting things about
SqlDom is that it's completely SQL language-agnostic (just like CodeDom is for CLR languages). The SqlDom
provides types that represent many common types of SQL code statements (SELECT. UPDATE, DELETE,

...). This object graph can be rendered as SQL source code for a specific target platform using persistence
producers (such as the SqlServer producer). The CodeFluent View tool is also capable of displaying a

pseudo representation of each procedure in the model.

View: a model view (defined in OOP concepts) can be optionally associated with a persistence view.

User Interface concepts

These concepts are mostly abstract, their main purpose being to define common concepts across the model, that
may be used by configured producers targeting User Interface applications (such as the Web Site producer or the
SharePoint producer). User interface concepts can be grouped in two distinct domains.

UI Application concepts

Application: an application contains StyleSheets, ControlDefinitions, and Cultures, which are CodeFluent
User Interface concepts as well.

Control Definition: a Control is the smallest reusable unit of a CodeFluent application. A ControlDefinition
defines the class of a Control instance. For example, the Web Site producer uses a 1:1 mapping between a
CodeFluent ControlDefinition and an ASP.NET control class (an .ascx file or a custom control class).

Control: an instance of a ControlDefinition. A control instance can have a collection of child controls
instances. For example, the Web Site producer uses a 1:1 mapping between a CodeFluent Control and the
textual declaration of a control inside an .ascx or .aspx ASP.NET file.

Renderer: a renderer is associated with a Typed Object (Section 2.3.1.1.2). Using renderers, it is possible
to define common UI behavior for properties, method arguments, etc... In the Web case, renderers can be used
to automatically associate control validators with controls.

Window: a Window is just a control with a title. For example, the Web Site producer uses a 1:1 mapping
between a CodeFluent Window and an ASP.NET .aspx Page.

StyleSheet: an abstract style sheet defined at Application level. CodeFluent itself does not do anything with
it, except defining it. But the Web Site producer, for example, uses a 1:1 mapping between a CodeFluent
StyleSheet and an HTML CSS style sheet.

Culture: an application may be defined for more than one culture. The culture concept is very close to the
.NET Framework's CultureInfo class.

UI Forms concepts

These concepts are used to represent a common Ul paradigm. There are not directly related to UI application
concepts at CodeFluent Model level. Both can be used without being explicitly related. They are mostly related at
production time, not a design time.

For example, a Control defined in the CodeFluent model can be mapped, at production time, by the Web Site
Producer, to an ASP.NET Web Control defined as a CodeFluent Template. The code in this template can leverage
the UI Forms concept defined in the model to create the corresponding ASP.NET controls hierarchy, based on
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ASP.NET existing control, such as FormView, MultiView, TabStrip, etc....
Form: a form is related to an entity, and contains tabs. An entity has a default Form and a create Form always
defined.
Tab: a tab contains columns. By default, a tab has just one column.

Column: a column contains fields. A column is just referenced by its index (0 is the first column) in the
containing tab.

Field: a field has a name and a Typed Object associated with it.
Field Renderer: similar to a Typed Object renderer, it is used to renderer a field in a custom way.

Because a Form (see below) is related to an entity, Forms and their contained elements rely heavily on the
inheritance concepts. Forms attached to an entity that derive from a base entity will, by default, inherit from
Forms attached to that base entity. They can also "override" the form definition, add a new Tab, remove a column
in a specific tab, etc...

2.3.1.1.2 Type System

Some of CodeFluent design concepts (Section 2.3.1.1.1) are strongly typed. Those concepts are referred
to Typed Objects Concepts:

¢ Entity and View Properties
e Method and Rule Parameters.

CodeFluent types

CodeFluent type system is a composite one, because it must adapt to the underlying target type systems:

o the CLR type based on the Common Language Runtime type system
¢ the Persistence type based on the System.Data.DbType enumeration
¢ the UI type based on the CodeFluent Ul type system.

CodeFluent CLR Type Persistence Type Ul Type
Type and

alisases

bool System.Boolean DbType.Boolean Boolean

boolean, bit
byte System.Byte DbType.Byte Integer

char System.Char DbType.Byte if persistenceUnicode is set to false ~ Character

DbType.Int16 if persistenceUnicode is set to true

currency System.Decimal DbType.Currency Currency

money, cost,

price

datetime System.DateTime DbType.DateTime DateTime
date, time

double System.Double DbType.Double Double
real
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single

float

object

any, anyvalue
guid
uniqueidentifier
decimal

sbyte

elapsedtime

timespan
int
int32, integer

long
int64

short

int16

uint

uint32

ulong

uint64

ushort

uint16

byte

xml

string

text

email

mail

password

System.Single

System.Object

System.Guid

System.Decimal
System.SByte

System.TimeSpan

System.Int32

System.Int64

System.Int16

System.UInt32

System.UInt64

System.UInt16

System.Byte

System.String

System.String

System.String

System.String

DbType.Single

DbType.Object

DbType.Guid

DbType.Decimal
DbType.Sbyte

DbType.DateTime

DbType.Int32

DbType.Int64

DbType.Int16

DbType.Ulnt32

DbType.Ulnt64

DbType.Ulnt16

DbType.Byte

DbType.AnsiString if persistenceUnicode is set to
false

DbType.String if persistenceUnicode is set to true

Note: some persistence producers may handle this
type specifically. This is for example the case with
the SQL Server producer, configured in SQL 2005
mode.

DbType.AnsiString if persistenceUnicode is set to
false
DbType.String if persistenceUnicode is set to true
DbType.AnsiString if persistenceUnicode is set to
false

DbType.String if persistenceUnicode is set to true

DbType.AnsiString if persistenceUnicode is set to
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AnyValue

Uniqueldentifier

Number
Integer

ElapsedTime

Integer

Integer

Integer

Integer

Integer

Integer

Integer

Xml

Text

Email

Password
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url

hyperlink

richstring

richtext

data
byte[], binary

file

attachment,
document

blob

largebinary

film

video

image

picture, photo

audio

sound

System.String

System.String

System.Byte[]

CodeFluent
Runtime
provided

CodeFluent
Runtime
provided

CodeFluent
Runtime
provided

CodeFluent
Runtime
provided

CodeFluent
Runtime
provided

Specific types

CodeFluent type

CLR
Type

Full CLR type name  The

specified

type
name

Model defined entity The

or entity collection

Model

defined enumeration

name

The

Enum

CLR type

entity or
collection
CLR type

generated

false

DbType.String if persistenceUnicode is set to true

DbType.AnsiString if persistenceUnicode is set to
false

DbType.String if persistenceUnicode is set to true

DbType.AnsiString if persistenceUnicode is set to
false

DbType.String if persistenceUnicode is set to true

DbType.Binary

DbType.Binary

DbType.Binary

DbType.Binary

DbType.Binary

DbType.Binary

Persistence Type

DbType.Object

Depends on the relation implicitely defined

The enumeration's DbType (DbType.Byte,
DbType.SByte, DbType.Int16, DbType.Ulnt16,
DbType.Int64, DbType.UInt64, DbType.Ulnt32, or
DbType.Int32).
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name MultiChoice

if
enumeration
is multi-
valued

Example 1 : Using a CLR type for a property

The following example declare a property Culture with the CLR type System.Globalization.CultureInfo,
this property will be serialized depending on its persistenceSerializationMode attribute value before its
container entity is persisted.

XML

<cf:property name="Culture" typeName="System.Globalization.CultureInfo"™ />

Example 2 : Declaring a custom user type

The following example declare a user type DateNow of type DateTime.

XML

<cf:userType name="DateNow" typeName="DateTime">
<cf:rule typeName="OnCreate" expression="System.DateTime.Now" />
</cf:userType>

CodeFluent Ul Type System

Since CodeFluent can generate User Interface applications, every Typed Object needs a UI Type as well as a
persistence type and a model type.

These types are used by UI producers such as the Web Site or the SharePoint producer. For example, the
HyperLink UI type will be rendered as an ASP.NET HyperLink control. How a CodeFluent UI type maps to a final
UI type depends upon the UI producer capabilities and configuration.

UlType Description

AnyValue Any simple type value.

Association A Many to Many relation between two project entities.

Boolean A boolean value.
Can be displayed as a Yes/No or True/False drop down list, or radio button list for
example.

Binary A byte array.

BinaryLarge Alarge byte array.

The difference between a Large byte array and a byte array is a matter of convention or
producer configuration.

Character A unicode character.
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Choice

Currency

DateTime

ElapsedTime
EMail

File

HyperLink

Image

Integer

MultiChoice

Number

Password

Relation

RichText

Text

Uniqueldentifier

Video

Xml

This type is rarely used. String is preferred.

A choice of values.

Can be displayed as a drop down list for example.

A currency.

Can be displayed with a currency sign (in general, using CLR internationalization
features).

A Date and/or Time.
Can be displayed with a calendar in ASP.NET for example.

An elapsed time. Correspond to the TimeSpan CLR type.
An email address.

A file.

Can be displayed by an Icon and an action on click for example.

An URI.
Can be displayed by an HREF HTML tag in a web application for example.

An image (photo, picture, ...).

Can be displayed by a thumbnail or a complete image for example.
A signed or unsigned integer type.

A choice of values that can be combined.

Can be displayed as a check box list for example.
A floating point or integer number.

A password.

Can be displayed by a list of ****** for example.
A relation between two project entities.

A rich text string.

Can be displayed by an word processing or editor in edit mode, for example.
A string.
A GUID (globally unique identifier).

A video file.
Can be displayed by an embedded Video Player for example.

An XML string.

2.3.1.1.3 Reusing .NET Types

Using CodeFluent Entities, you can store existing .NET types data to the persistence layer, whatever the
persistence layer is: SQL Server, Oracle database, etc.
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In fact, there are several ways to do it.

OK, let’s suppose we want to store, graphical shapes in the database. We define this very simple model, defining
coordinates, width and height of the shape bounding rectangle:

Model (XML)

<Shape>
<Id />
<BoundsX typeName="int" />
<BoundsY typeName="int" />
<BoundsW typeName="int" />
<BoundsH typeName="int" />
</Shape>

Defining a Shape object is in fact a heresy, since there is an existing .NET type “Rectangle”, in the
System.Drawing namespace, from the standard System.Drawing assembly. Instead of defining an extra custom
object, we can use the standard .NET type.

To do so, you can define a property to be a standard CLR type such as:

Binary Serialization

<Shape>

<Id />

<Bounds typeName="System.Drawing.Rectangle" />
</Shape>

This works fine because CodeFluent Entities tries to serialize everything it does not “know”. That works fine
because CodeFluent Entities tries to serialize everything it does not “know”. Known types are (using C# aliases
when it exists): int, uint, long, ulong, short, ushort, byte, sbyte, byte[], bool, float, double, decimal, string, char,
System.Guid, System.DateTime, System.TimeSpan, explicit CodeFluent blob types (declared using “file”, “video”,

» o«

“image”, “audio”), all enum (System.Enum) types.
4 Note: Known types are fully documented in the Type System (Section 2.3.1.1.2) article.

For all other “unknown” types, CodeFluent Entities uses serialization. Several kinds of serialization are
supported: binary serialization, XML serialization, and Lightweight serialization.

Binary Serialization

First, CodeFluent checks to see if the type implements the "IBinarySerialize" (from the
Microsoft.SqlServer.Server namespace) interface. This is especially useful for SQL 2008 types such as the
"SqlGeography" type.

Then, CodeFluent Entities uses what has been configured on the property. This is defined by the model attribute
persistenceSerializationMode. The default value is Binary | ArrayOfBytesType. It means the .NET
instance will be serialized using .NET standard serialization (not XML, nor SOAP), and stored as an array of
bytes.

Thus, our rectangle will be serialized as an array of bytes. With this model, the corresponding Bounds column
data type in the database will be TEXT/NTEXT (SQL server) or BLOB (Oracle).

With the following C# using the generated Business Object Model (please note that we use the standard .NET
Rectangle type, as expected):

Using the object model

Shape shape = new Shape();
shape.Bounds = new System.Drawing.Rectangle (10, 20, 30, 40);
shape.Save () ;

We will have this in SQL Server:
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XML Serialization

Now, we could use XML Serialization instead of the binary one used by default. To do so, we need to specify the
persistenceSerializationMode attribute:

XML Serialization

<Shape>

<Id />

<Bounds typeName="System.Drawing.Rectangle" persistenceSerializationMode="Xml |
StringType" />
</Shape>

Because we used Xml combined with StringType, the corresponding “Bounds” column data type in the database
will be XML (supported in SQL Server 2005 or higher and Oracle Database 10 or higher). With the same C# code
as previously, here's what will have this in SQL Server:

i e b e

s S 23D J el .
i iy 8 v AR

0 E i 4 B e T

If we click on the Xml column, we can see the Rectangle instance was automatically serialized as plain Xml,
thanks to CodeFluent Entities:

B B e M o g o e

Lightweight Serialization
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Now, let’s suppose we want to load all our shapes ordered — server side — by the rectangle area, or we want to
write some back end process that needs to access to the inner properties of the stored rectangles. What we want
to do is have the X, Y, Width and Height properties available in the persistence layer.

As you know, Lightweight Entities (Section 2.3.1.3.7) can be mapped to existing .NET types, so a solution
would be to declare the Rectangle .NET type as a lightweight entity. Here's how to do it:

Lightweight Serialization

<cf:project xmlns:cf="http://www.softfluent.com/codefluent/2005/1"
defaultNamespace="Test" assemblyPaths="System.Drawing">
<Rectangle namespace="System.Drawing, System.Drawing">
<X />
<Y />
<Height />
<Width />
</Rectangle>

<Shape>
<Id />
<Bounds typeName="System.Drawing.Rectangle" />
<cf:method name="LoadOrderedByBoundsSize" body="load() raw">
SELECT * FROM Shape ORDER BY Bounds_ Shape Rectangle Width *
Bounds_Shape Rectangle Height
</cf:method>
</Shape>
</cf:project>

In this model, you can see we are declaring a regular entity named "Rectangle” in the namespace
System.Drawing. The namespace attribute notation here includes the assembly name as well (without culture
and version).

[ Note: The project node also has an assemblyPaths attribute that helps CodeFluent Entities to determine
if an entity is an existing type or not. The value of assemblyPaths is just a comma separated list of physical
assembly paths, or GAC names.

When an existing type is declared as an entity, this entity does not have the notion of key properties. You just
need to declare what properties you want CodeFluent Entities to use when persisting an instance of it. These
properties must exist and the name is case sensitive. In the case of Rectangle, X, Y, Height and Width are real
properties and are all of the System.Int32 type. Rectangle also has Bottom and Left properties, but since they are
redundant, we don’t declare them. The persistence type is automatically determined by CodeFluent using
Reflection techniques.

In this example, the method is a RAW method because CodeFluent does not allow the * notation in an order by.

In the database we now have 4 columns representing the Bounds property. If we use the same previous C# code,
this is what we have in the database:

Using Persistence Layer Specific Types
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In the cases mentionned above, we used standard CLR types serialized in byte arrays, XML or into a lightweight;
however if your persistence layer provides a specific type to store it you can also use it.

For instance, there are no geography or hierarchyid types in CodeFluent Entities as those are way too specific to
SQL Server 2008. Nevertheless, you can still use them in your model.

Here's how to do it:
Using the Geography Type

<cf:project xmlns:cf="http://www.softfluent.com/codefluent/2005/1"

xmlns:cfps="http://www.softfluent.com/codefluent/producers.sglserver/2005/1"
defaultNamespace="Test"

assemblyPaths="c:\temp\Microsoft.SglServer.Types.dl1l"> <!-- adapt this
to your machine -->
<Address>
<Id />

<Spatiallocation cfps:dataType="geography"
typeName="Microsoft.SglServer.Types.SqlGeography, Microsoft.SglServer.Types" />
</Address>
</cf:project>

2.3.1.1.4 Model Structure

This topic presents the structure of a CodeFluent model.

Every CodeFluent model is defined in a set of one or more XML files, this set of XML files is named a CodeFluent
package.

Every CodeFluent package must have a root XML file where you import the other XML files. For example, you
can have a root XML file where you declare your entities, a XML file where you declare your producers and a
XML file where you declare your business rules.

CodeFluent packages can be compressed in ZIP or CFX file formats. CFX files are in fact standard ZIP compatible
files. CodeFluent tools (Section 2.2) recognize XML format and compressed formats as well. For example,
suppose that you have a model split into two model parts: MyModel.xml and MyModel.Producers.xml,
with MyModel.xml importing the MyModel.Producers.xml part. For instance you use the following
command to generate the output:

o CodeFluent.build.exe MyModel.xml

It's also possible to zip the two parts into a package and rename its extension from ZIP to CFX, and use the
following command:

¢ CodeFluent.build.exe MyModel.cfx

Root Producers
[Model Part] [Model Part]

MyModdlaomd B Myldodel Producers omd

Methods Instances
[Maodel Part] [Model Part]

(phAnadel Mt hoads wmd IbegAbohed | anns ol
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Example

This example show a CodeFluent package composed of two XML files:

the root file MyModel.xml
the producers file MyModel.Producers.xml

Root XML File

<cf:project xmlns:cf="http://www.softfluent.com/codefluent/2005/1"
defaultNamespace="MyModel"
defaultKeyPropertyTypeName="int">

<!-- Import MyModel.Producers.xml -->
<cf:import path="MyModel.Producers.xml" />

<Employee>

<Id />

<Name />

<Age typeName="int"/>
</Employee>

</cf:project>

Producers XML File

<cf:project xmlns:cf="http://www.softfluent.com/codefluent/2005/1"
defaultConnectionString="server=(local)\SQLEXPRESS;database=HowTo; Integrated
Security=true">

<!-- Persistence Producer -->
<cf:producer typeName="CodeFluent.Producers.SglServer.SglServerProducer,
CodeFluent.Producers.SglServer">
<cf:configuration targetDirectory="..\Generated\Sqgl" />
</cf:producer>

<!-- Business Producer -->
<cf:producer typeName="CodeFluent.Producers.CodeDom.CodeDomProducer,
CodeFluent.Producers.CodeDom">
<cf:configuration targetDirectory="..\Generated\Model" outputName="
{0}.d1i1" />
</cf:producer>

</c®€:project>

2.3.1.1.5 Model Schema

This topic presents the schema of a CodeFluent design model.

Schema Nodes Concepts

All CodeFluent concepts are represented in a CodeFluent model, which is an XML Infoset.

CodeFluent internally defines another level of abstraction besides the XML standard element / attributes
XmlNode-based model. This abstraction is defined as the CodeFluent Document Object Model (CFDom). In
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the CFDom, concepts are represented as CFNodes. CFNodes have the following common characteristics:

A CFNode has a type.

A CFNode has a collection of child messages (Section 2.5.1.1.1.1.1.1.1).
A CFNode has a collection of child attributes (Section 2.5.1.1.1.1.1).

A CFNode has a unique 'permanent' identifier (the NodelId).

A CFNode is linked to an XmlElement.

A CFNode has an origin (a Part (Section 2.3.1.1.4)).

A CFNode can be Enabled (using the enabled Xml attribute). A disabled node is not seen by the CodeFluent
model parser, but it is still considered part of its containing Part in the containing Package (Section
2.3.1.1.4).
« A CFNode can be UlEnabled (using the uiEnabled Xml attribute). A UI disabled node should not be seen by
. User Interface concepts (Section 2.3.1.1.1), and should not be used by User Interface producers.

NodeType

[ ]
Wode types match closely CodeFluent concepts. There is an Entity node type, a Property node type, etc...
lzroducers are also CFNodes.

Messages

Messages are used for User Interface producers. Since every message has a culture, they are also very important
for enabling multilingual applications. For example, the Business Object Model Producer builds a .NET resource
entry for every message defined in the CodeFluent model, using standard .NET culture-base satellite dlls.
Attributes

The meaning of the Attributes collection depends on the CFNode type. For example, Entities and Methods
CodeFluent attributes are used by the Object Model producers to define CLR Custom attributes.

Nodeld

This identifier is a 128 bits value, function of the node definition. This purpose of this value is to define a unique
identifier that does not change across builds. The value changes only if the node's definition 'really changes'. How
the Nodeld is exactly computed depends on the type of node. For example, entity nodes identifier is linked to the

entity full namespace. It means the Nodeld will not change unless the entity is renamed or its namespace is
changed.

Using the CodeFluent API, the node identifier allows direct access to a CFNode (it is similar to the id attribute
coupled with the getElementByld function in web javascript pages). This is used in User Interface templates
for example.

ShortNodeld

This identifier is a string, function of the node definition. It is unique for a given project.

E Note: The short node id is computed just before production. It is therefore not available at Modeling time.

XmlElement
Every node is loaded from an XML Infoset element. This underlying element is publicly accessible.
Origin

The origin of a node is the Part in the model Package that defines the node. CodeFluent also defines the notion
of Relative Origin which can be used to automatically define entity namespaces, or category paths.

Schema Nodes Declaration: Free and normal forms
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There are two ways for declaring entities, properties and enumerations in a CodeFluent design model :

by using the Normal schema form
by using the Free schema form.

¥ Normal and Free schema forms can be mixed in a common CodeFluent model.
Both ways are completely equivalent to the CodeFluent parser.

Normal Schema

The Normal schema form can be useful if you need to formally access the XML structure, using XSLT
transformation for pre or post processing CodeFluent models. The Free schema is easier to read and understand
by a developer if edited directly with a text editor. The Free schema is not well suited for formal XML validation.

XML

<cf:project xmlns:cf="http://www.softfluent.com/codefluent/2005/1"
defaultNamespace="MyModel">

<cf:entity name="Customer">
<cf:property name="Id" />
<cf:property name="FirstName" />
<cf:property name="LastName" />
</cf:entity>

<cf:enumeration name="CreditCardType">
<cf:enumerationValue name="Visa" />
<cf:enumerationValue name="MasterCard" />
</cf:enumeration>

</project>

Free Schema

In the Free schema form, the CodeFluent parser assumes that every XML element under the project element
which is not in the CodeFluent XML namespace is an entity. It assumes as well that any XML element under an
entity element which is not in the CodeFluent XML namespace is a property of that entity. For enumerations,
CodeFluent uses the 'Enum’ suffix to differentiate between entities and enumerations. XML element under an
enumeration are parsed as enumeration values.

XML

<cf:project xmlns:cf="http://www.softfluent.com/codefluent/2005/1"
defaultNamespace="MyModel">

<Customer>
<Id />
<FirstName />
<LastName />
</Customer>

<CreditCardTypeEnum>
<Visa />
<MasterCard />
</CreditCardTypeEnum>
</project>
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Using external variables in a model

When you author CodeFluent model files, you might need to use external variables, for example, when people in a
team share the same model, but each one produces in his/her own environment. CodeFluent models allow to use
three different types of external variables, with associated syntax:

Command line arguments: use %=<index>% as a placeholder for the value of the argument at index
specified by <index>

Named command line arguments: use %=<name>% as a placeholder for <value>, <name> being the
name of the argument if the argument format is /<name>:<value> or -<name>:<value>

Windows environment variables: user %<name>% as a placeholder for the value of the environment
variable named <name>

Any of these variables can be used directly in CodeFluent model's XML attributes.
Example

If we define the following model, the environment variable CF_TEMPLATES_PATH (created by the standard
CodeFluent Command Prompt tool) will be used to form the sourceDirectory attribute.

XML

<cf:project ...>

<cf:producer enabled="%=produceIFs"
typeName="CodeFluent.Producers.CodeDom.TemplateProducer,
CodeFluent.Producers.CodeDom">
<cf:configuration
sourceDirectory="%CF TEMPLATES PATH%\DataInterface"
targetDirectory="..\Interfaces"
outputName="..\bin\{0}.Interfaces.dll"™ />
</cf:producer>

</cf:project>

The following batch command will produce the interface assembly.

CMD

CodeFluent.Build.exe myModel.xml /producelIF:true

Using Reserved XML Characters in a model

The following table describes the reserved XML characters that must be replaced by the corresponding named
entity so that the model file can be parsed.

Note: do not get confused with the term "entity" which is specific to XML, and is totally unrelated to the
CodeFluent "entity" term.

Reserved character Named entity
< &lt;

> &gt;

& &amp;
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&quot;

&apos;

To use double quotes in a model file

Replace the double quotes with the corresponding named entity, &quot;. For example, to place double quotes
around the Ent ity node type name, type:

XML

<cf:method name="LoadFix" body="load () where Name = &quot;Joe&quot;"/>

2.3.1.2 Projects

The project node is the root node of each XML file that is part of a CodeFluent model and represents your
development project.

In other words, every CodeFluent model part has one and only project node which contains all other nodes. If a
part imports some secondary parts, the project node of the secondary parts will inherit the attributes of the root
project node.

[ Note: The project node has many attributes whose name starts with default. This means those attributes have
their counterparts in some child nodes; and unless they are overridden in child nodes, the defined value will act
as the default one.

For instance, the project node has a defaultConnectionString attribute which defines the default value of
the connectionString attribute of the configuration node. This way, unless a connection string is explicitly
defined for a specific producer configuration, all producers will use the defined defaultConnectionString.

In This Section

How to: Declare a project (Section 2.3.1.2.1)

Information about how to declare a project in a CodeFluent model.

How to: Explore a project (Section 2.3.1.2.2)(Section 2.3.1.3.6)

Information about how to explore a project in the CodeFluent Meta Model Explorer (Section 2.2.4).

2.3.1.2.1 Declaring a project

This topic explains how to declare a project in a CodeFluent design model.

Example

This example shows a CodeFluent model is composed of two XML files:
e aroot XML file named Crm.xml,
e asecondary XML file named Crm.Referential.xml.
Crm.xml

<cf:project xmlns:cf="http://www.softfluent.com/codefluent/2005/1"
defaultNamespace="Crm"
defaultKeyPropertyTypeName="int"
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defaultPropertyTypeName="string"
defaultConnectionString="server=127.0.0.1;database=HowTo; Integrated
Security=true">

<cf:import path="Crm.Referential.xml" />

</cf:project>

In the root XML file, the following attributes of the project node were defined:

defaultNamespace: the default namespace for entities,
defaultPropertyTypeName: the default type to use for properties,
defaultKeyPropertyTypeName: the default type to use for key properties,
defaultConnectionString: the default connection string for persistence producers.

In the secondary XML file, the project node has only the xmlIns:cf mandatory tag that references the
CodeFluent namespace, all the attributes are inherited from the root XML part.

The Customer entity is declared in the Crm.Referential namespace ({0} is equivalent to the default
namespace) and it has the following properties :

Key property Id with typeName int (see the defaultKeyPropertyTypeName attribute)

Secondary properties FirstName, LastName, Password and Email with typeName string (see the
defaultPropertyTypeName attribute)

Secondary property Address with typeName Crm.Referential. Address

. o
Crm.Referential.xml
<cfgproject xmlns:cf="http://www.softfluent.com/codefluent/2005/1">

.<Customer namespace="{0}.Referential">
<Id />
<Email />
<Password />
<FirstName />
<LastName />
<Address typeName="namespace="{0}.Referential.Address"/>
.</Customer>
® <Address namespace="{0}.Referential">
<Id />
° <Linel />
<Line2 />
<City />
<Zip />
<Country />
</Address>

</cf:project>

2.3.1.2.2 Exploring a project
This topic explains how to explore a Project in the CodeFluent Meta Model Explorer.

Exploring model parts

Loading in the CodeFluent MetaModelExplorer the root part of the model declared in Declaring a project
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(Section 2.3.1.2.1), one can explore model parts through the following properties:

ModelParts: Crm.xml and Crm.Referential.xml.
RootModelPart: Crm.xml.

Then, if one expands the ModelParts property, one can have a detailed view of the model parts Crm.xml and
Crm.Referential.xml.
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Exploring project attributes

All properties applying to an entity are displayed in its related property grid. Among the selected entity attributes,
you'll find project attributes applying to the current selected entity.

Here are two screenshots of those attributes. In the screenshots below, attributes are grouped by category. The
first screenshot shows attributes related to the persistence layer, whereas the second one shows attributes related
to the Business Model layer.
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Exploring project layers

It's then possible to navigate through the full project by domain such as the Business Model Layer, the
Persistence Layer, and the UI Layer.

Selecting an object in the tree view will display a detailed view of the object in the main window.

You can notice that in the Persistence layer, you have Virtual Tables and Virtual Procedures. This is
because, at this stage, CodeFluent only loaded the model in memory but no output was generated (no tables nor
views or any stored procedures).

2.3.1.3 Entities

The first stage when developing an application using CodeFluent Entities is to define your business logic in your
model, and that's exactly what entities do: each entity represents one of your concepts.

Navigate through this section to know more about entities.
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